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About This Guide

The Audio/Video User’s Guide for the Silicon Graphics 320™ and Silicon
Graphics 540™ Visual Workstations describes how to use the audio and vide
features of the Silicon Graphics Visual workstations. This guide contains
following chapters:

• Chapter 1, “Getting Started”

• Chapter 2, “Recording and Playing Audio”

• Chapter 3, “Capturing and Playing Video with VidCap and Video for 
Windows”

• Chapter 4, “Capturing and Playing Video with HackTV and 
QuickTime”

• Chapter 5, “Silicon Graphics Video Compression Techniques”

• Appendix A, “NTSC and PAL”
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Intended Audience

This guide is intended for both novice and experienced video editors. Th
broad range includes people involved in video editing, composition, and
animation, Web designers, game developers, or those in similar endeav
who require high-quality, full-motion video and audio editing. Readers of t
guide should thoroughly understand digital video editing techniques and
familiar with video editing application software.

This document refers to the English-language editions of Video for Windo
and QuickTime.

Additional Information

For additional sources of information, consult the following documents:

• Silicon Graphics 320 Visual Workstation Owner’s Guide

• Silicon Graphics 540 Visual Workstation Owner’s Guide

• Digital Media Programming Guide for Windows NT

• Silicon Graphics SD1100™ Serial Digital Video Interface Board 
Owner’s Guide

• Silicon Graphics MJ1100™ M-JPEG Compression Card Owner’s 
Guide

• Silicon Graphics DA1100™ Digital Audio Card Owner’s Guide

Contacting Customer Support

Support contact information can be found in the Owner’s Guides or on y
system (go to Start > Silicon Graphics > Support).
xiv
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Chapter 1

1. Getting Started

This chapter explains the multimedia features of the Silicon Graphics 320
Silicon Graphics 540 workstations and how to use them to capture video
audio from an external source.

This chapter discusses the following topics:

• “Hardware Overview” on page 2

• “Software Overview” on page 6

• “A Simple Video Capture Example” on page 10
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Hardware Overview

The Silicon Graphics 320 and Silicon Graphics 540 workstations are 
high-performance multimedia workstations. They come with built-in 
software and a complete set of audio and video back-panel connectors 
allow you to capture high-quality video and audio from a variety of sourc
Designed to run with Microsoft Windows NT, both workstations present 
professional digital video editors with the ease of use and convenience o
Windows NT operating environment.

The Silicon Graphics 320 workstation supports up to two Pentium II or 
Pentium III processors, while the Silicon Graphics 540 workstation suppo
up to four Pentium III processors.

In addition to the features offered in the basic versions of the workstatio
Silicon Graphics offers the following options to boost performance:

• The Silicon Graphics DA1100 Digital Audio Card—multichannel 
digital audio capability and audio/video synchronization board

• The Silicon Graphics MJ1100 MJPEG Compression 
Card—dual-channel M-JPEG compression board

• The Silicon Graphics SD1100 Serial Digital Video Interface Board—
digital video capture and external synchronization board

• The Silicon Graphics DS1100 Disk Array—disk array that enables 
full-motion video capture and playback of compressed and 
uncompressed material with high-capacity storage

• The Silicon Graphics 1600SW Flat Panel Monitor—a thin-profile 
high-performance display

More information about these options is found later in this guide.
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Silicon Graphics 320 Visual Workstation

The Silicon Graphics 320 workstation provides the following multimedia
features:

• CD-quality stereo line-level audio input and output (two RCA jacks)

• Composite video input and output (two RCA jacks)

• S-Video input and output (two S-Video jacks)

• Speaker/Headphone output (mini jack)

• Microphone input (mini jack)

• Hardware support for audio and video synchronization

You can install the following options in the Silicon Graphics 320 workstati

• Silicon Graphics DA1100 Digital Audio Card

• Silicon Graphics MJ1100 M-JPEG Compression Card

• Two types of 64-bit PCI Hard Disk Controller Cards to control the 
Silicon Graphics DS1100 Disk Array:

– SCSI

– Fibre Channel

Figure 1-1 shows the back of the Silicon Graphics 320 workstation.
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Figure 1-1 Back View of Silicon Graphics 320 Workstation
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Silicon Graphics 540 Visual Workstation

In addition to the multimedia features provided by the Silicon Graphics 3
workstation, the Silicon Graphics 540 workstation offers compatibility wi
the Silicon Graphics SD1100 Serial Digital Video Interface Board, and 
additional PCI expansion slots, as shown in Figure 1-2, which shows the b
of the Silicon Graphics 540 workstation.

Figure 1-2 Back View of Silicon Graphics 540 Workstation
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Software Overview

This section explains the software environment, tools, and panels the 
workstations use to capture video. 

Software Environments

The workstations include full support for the following digital media softwa
environments:

• Microsoft Windows Multimedia, including Video for Windows

• Apple QuickTime for Windows

Windows Multimedia

The Windows Multimedia environment includes the following tools and 
graphical panels:

• VidCap32 video capture tool1

• Sound Selection panel

• Media Player panel

• Windows Volume and Recording panels

• Silicon Graphics Video for Windows Capture Settings panel

Apple QuickTime

The Apple QuickTime environment includes the following tools and pane

• HackTV video capture tool1 (downloadable from Apple’s website)

• Sound Control Panel for control of compression, source, and sampl

• Video Control Panel for control of compression, source, and imaging

• Windows Volume and Recording panels

1 Other third-party applications may also be used for capturing and editing video.
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Silicon Graphics Control Panels

In addition to Windows and QuickTime, Silicon Graphics provides the 
following control panels, which are accessible from the Silicon Graphics
System Tray icon or from the System Control Panels folder:

• Silicon Graphics Audio Control Panel

• Silicon Graphics Video Control Panel

The software environment is explained in detail in Chapters 2 and 3.

In addition to the software included with the workstations, sophisticated 
third-party software may be purchased that allows you to capture and ed
video and audio. These third-party applications are based on either Micro
Video for Windows or Apple QuickTime. Some third-party tools support on
one or the other and some support both. Because Apple QuickTime offe
somewhat better performance, Silicon Graphics recommends that you u
multimedia software based on QuickTime where possible.

The software can be considered to exist at three levels or layers:

• Application Control Panels and Dialog Boxes

• Developer API (application program interface) Layer

• Driver Layer

Figure 1-3 shows the general software environment for Windows 
Multimedia.
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Figure 1-3 Windows Multimedia Software Environment

Some of the panels shown in Figure 1-3 are brought up by the VidCap 
application (or other third-party applications), and others are brought up f
the Windows System Tray or from the Windows Control Panel. Each pan

Video for Windows
video application

Windows
multimedia

environment
(WAV, MIDI,
AVI, Joystick,

Video for Windows)

Silicon Graphics
video capture

driver

Silicon Graphics
 audio driver

Silicon Graphics
video compression

driver

Audio settings panels

Video settings panels

Sound Selection panel

Silicon Graphics 
Video for Windows (VFW) 

Capture Settings panel

Silicon Graphics 
Video Control panel

Driver
layer

Developer
API

layer

Control panels
and

dialog boxes

Silicon Graphics
Audio Control panel

Windows
volume and recording 

control panels

Silicon Graphics 
Video for Windows (VFW) 

Output Settings panel
8   Chapter 1



uent 

.

has its own submenus and dialog boxes, which are explained in subseq
sections of this guide. 

Figure 1-4 shows the general software environment for Apple QuickTime

Figure 1-4 Apple QuickTime Software Environment
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A Simple Video Capture Example

This section explains how to hook up your NT workstation to an externa
video source, capture video using both the Windows VidCap and QuickT
HackTV applications, and play it back.

Makin g the Connections

In this example, the workstation is connected to a television and to an exte
VCR that plays back a video source tape. The connections are made as s
in Figure 1-5.

Figure 1-5 Connections to an External Video Source

Note: This connection configuration assumes that your VCR has an 
S-Video output. If it does not, connect its composite video 
output to the NT workstation’s composite video input.
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Capturin g Video Usin g VidCap

In this example, you capture a 2-second video clip to hard disk using the
VidCap application. The following sections illustrate the steps to follow t
perform the capture.

Start the Application

1. Bring up the VidCap application by double-clicking the VidCap32.ex
icon, located at C:\WINNT\SYSTEM32.

The VidCap main screen appears, as shown in Figure 1-6.

.

Figure 1-6 VidCap Main Screen
Getting Started   11



Choose the Audio Format

1. From the VidCap main menu bar, choose Options > Audio Format.

The Sound Selection window appears, as shown in Figure 1-7.
To capture audio along with the video, you must specify the audio 
quality, format, and attributes in this window.

.

Figure 1-7 Sound Selection Window

2. Choose CD Quality  in the Name box.

3. Choose PCM in the Format box.

4. Choose 44.100 kHz, 16-bit, Stereo, 172 Kb/s in the Attributes  box.
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Choose the Video Format

1. From the VidCap main menu bar, choose Options > Video Format.

The Silicon Graphics VFW Capture Settings screen appears, as 
shown in Figure 1-8.

.

Figure 1-8 Silicon Graphics VFW Capture Settings Screen

2. In the Silicon Graphics VFW Capture Settings screen, make the 
following selections:

– Source Jack: S-Video (or Composite In, depending on your 
VCR video output to the workstation)

– Source Timing: NTSC1

1 NTSC is the format for North America. The format may change for foreign countries. 
See Appendix A.
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– Color Settings: leave the default settings as is

– Captured AVI File Settings: 

Pixel Aspect Ratio: Square

Image Size: 320 x 240

Image Format: Uncompressed 32-bit BGRA or 16-bit 
Uncompressed UYVY.

3. Click Video Out... on the Silicon Graphics VFW Capture Settings 
screen.

The Silicon Graphics VFW Output Settings window appears, as 
shown in Figure 1-9.

.

Figure 1-9 Silicon Graphics VFW Output Settings Screen
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4. In this screen, make the following selections:

- Output Jack: Composite Out

- Output Timing: NTSC1

- Enable Video Display on Computer Screen: checked

5. From the VidCap main menu bar, choose Options > Overlay and click 
OK .

At this point, you should see motion video on the computer monitor. Vide
does not actually appear on the TV monitor except during the time video
actually being captured.

Create a Media File

1. From the VidCap main menu bar, choose File > Allocate File Space.

The Set File Size window appears, as shown in Figure 1-10.

.

Figure 1-10 Set File Size Window

2. In the window, enter 39 megabytes for the capture file size. This shou
be more than sufficient to hold two seconds of full motion, 
uncompressed video.

Note: This step may take a very long time for large file sizes. It is 
acceptable to skip this step.

1 NTSC is the format for North America. The format may change for foreign countries. 
See Appendix A.
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Set the Audio Record Level

1. From the Windows System Tray (located on the Taskbar), click the 
Silicon Graphics icon  and choose Audio Control Panel

The Silicon Graphics Audio Control panel appears, as shown in 
Figure 1-11.

.

Figure 1-11 Silicon Graphics Audio Control Panel

There are three areas on the panel: Play Control, Record Control, and Wave 
Input . The Record Control section lets you choose the recording source a
adjust the record level. The Play Control section lets you monitor and adjus
the audio level of various audio sources through the speakers and does
affect the recording level. The Wave Input section presents a dynamic visua
picture of the sound input.

2. Set up the Record Control section of the panel as follows:

– If the Wave Input panel is not displayed, click the small right 
arrow in the upper right of the Record Control panel to 
display it.

– Click the Line In   check box so that audio is recorded 
from the audio line inputs from the VCR. If the Wave Input 
panel does not display vertical bars, choose Options > Solid 
Meters. The vertical bars in the Wave Input panel should 
reflect the sound activity.

– Adjust the record slider so that the audio levels indicated in the 
two vertical bars in the Record Panel are as high as possible 
without clipping (red region).
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– Close the Wave Input panel before you actually start 
recording.

3. Set up the Play Control section of the panel as follows:

– Click the On button below the Line In  icon . This allows 
you to monitor the sound coming in from the VCR or other 
video source.

– Set the Line In   and Wave  volume sliders for an 
acceptable listening level.

Begin Capturing Video

1. From the VidCap main menu bar, choose Capture > Video.

The Capture Video Sequence window appears, as shown in 
Figure 1-12.

.

Figure 1-12 Capture Video Sequence Window

2. Set up the window as follows:

- Frame rate: 29.9701 for NTSC or 25 for PAL

- Enable Capture Time Limit: checked

- Seconds: 2

- Capture Audio: checked

- Capture Method: Directly to disk

1 Although the 29.97 number might seem unusual, it corresponds to the proper frame rate
for NTSC.
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3. If you are using tape in the VCR as a video source to capture, start 
tape.

4. Click OK

You see and hear video at the television monitor for two seconds. W
the two seconds elapses, the television screen goes blank. The follo
video file is now present on the hard disk:

C:\CAPTURE.AVI

Playin g Back the VidCap Video

To play back the captured video, double-click the CAPTURE.AVI file. Th
Windows Media Player opens and the captured video begins playing, as
shown in Figure 1-13.

Figure 1-13 Windows Media Player Window

Use the controls in the window to start, stop, and pause the displayed vi
18   Chapter 1
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Capturin g Video Usin g HackTV and QuickTime

In this example, you capture a short video clip to hard disk using the Hack
application. HackTV can be downloaded from Apple Computer’s Web si
and uses QuickTime to capture and play back video. Follow these steps
perform the capture:

Start the Application

1. Bring up the HackTV application by double-clicking the HackTV 
executable file.

The HackTV  main menu appears, along with real-time video playing 
the Monitor  window, as shown in Figure 1-14.

.

Figure 1-14 HackTV Main Menu and Monitor Window
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Choose the Video Format

1. From the HackTV Monitor  menu, choose Video Settings. The 
QuickTime Video Compression window, shown in Figure 1-15, 
appears.

.

Figure 1-15 Video Settings Compression Window

2. Choose Compression in the main drop-down box at the top of the 
window, and set up the options in the window as follows:

– Compressor: SGI ABGR

– Depth: Color

– Quality: Best

– Frames per Second: Best
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3. Choose Source in the main drop-down box. The window changes, as
shown in Figure 1-16.

.

Figure 1-16 Video Settings Source Window

4. Set the options in the window as follows:

- Digitizer: SGI Square Pixel

- Input: S-Video

- Format: NTSC
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5. Choose Image in the main drop-down box. The window changes, as 
shown in Figure 1-17.

.

Figure 1-17 Video Settings Image Window

6. Use the default settings, as shown in Figure 1-17.

7. Click OK .
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Choose the Audio Format

1. From the HackTV Monitor  menu, choose Sound Settings. The 
QuickTime Sound Compression window, shown in Figure 1-18, 
appears.

.

Figure 1-18 Sound Settings Compression Window

2. Choose Compression in the main drop-down box at the top of the 
window and set up the options in the window as follows:

– Compressor: None

– Speaker: On

– Volume: mid-range

– Gain: mid-range
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3. Choose Source in the main drop-down box. The window changes, as
shown in Figure 1-19.

.

Figure 1-19 Sound Settings Source Window

4. Set the options in the window as follows:

– Device: Built-in

– Input: Channel 1

– Speaker: Off While Recording

– Volume: mid-range

– Gain: mid-range
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5. Choose Sample in the main drop-down box. The window changes, as
shown in Figure 1-20.

.

Figure 1-20 Sound Settings Sample Window

6. Set the options in the window as follows:

- Rate: 44 kHz

- Size: 16 bits

- Use: Stereo

- Speaker: Off While Recording

- Volume: mid-range

- Gain: mid-range

7. Click OK .
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Begin Capturing Video

1. To begin capturing video, go to the HackTV main menu and choose
Monitor  > Record. The window shown in Figure 1-21 appears and 
allows you to specify a filename for the video you are about to captu
Because QuickTime normally uses a .MOV extension for its movie files, 
simply type Test.mov as the filename.

.

Figure 1-21 Filename Prompt Window

2. If you are using tape in the VCR as a video source to capture, start 
tape.

3. Click Save.

At this point, video is being captured to the hard disk. To stop captur
video, left-click the mouse. The prompt shown in Figure 1-22 appea
when you click the mouse.

Figure 1-22 End-of-Recording Prompt

4. Click OK .
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Playin g Back the Video

To play back the video you just captured, follow these steps:

1. Double-click the Test.mov file. The window shown in Figure 1-23 
appears.

.

Figure 1-23 QuickTime Playback Window

2. From the File menu, choose Present Movie. The prompt shown in 
Figure 1-24 appears.

Figure 1-24 Present Movie Prompt Window
Getting Started   27
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3. Set the options in the window as follows:

- Movie Size: Normal

- Mode: Normal

4. Click Play.

The movie plays to completion. You may use the controls at the bott
of the window to start, stop, and pause the displayed video.
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Chapter 2

2. Recording and Playing Audio

This chapter explains how to set up the Silicon Graphics 320 and Silicon
Graphics 540 workstation hardware and software to record and play bac
audio.

This chapter discusses the following topics:

• “Audio Inputs for Recording and Playback” on page 30

• “Audio System Architecture” on page 31

• “Windows Multimedia Audio Settings Panels” on page 33

• “QuickTime Audio Settings Panels” on page 41

• “Silicon Graphics Audio Control Panels” on page 45

• “Software Synthesizer and MIDI Support” on page 52
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Audio Inputs for Recording and Playback

Audio is provided to the workstations from the following sources:

• Microphone input jack (mini-jack on rear panel)

• Built-in CD player (internally connected)

• Line In (stereo RCA jacks on rear panel)

• Wave audio (directly from the CPU when playing a sound file)

Audio is played back from the workstations to the following destinations

• Line Out (stereo RCA jacks on rear panel)

• Speaker Out (mini jack on rear panel)
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Audio System Architecture

Figure 2-1 shows the overall architecture of the audio recording and playb
system in the workstations.

Figure 2-1 Audio System Architecture
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As shown in Figure 2-1, each audio input has separate record and playb
level controls. The only exception is that the digital audio from the CPU 
.wav file) does not have a record control.

Although Figure 2-1 shows separate record controls for each audio inpu
actuality, only one audio input can be recorded at a time. The selected in
record level is set by a single slider (see Figure 1-11 on page page 16). 
top of Figure 2-1 shows a rotary switch, which is intended to convey that o
one of the inputs can be recorded by the CPU. The audio is typically reco
to memory, and can later be saved to disk as a .wav file.

There are individual playback controls for each audio source, including fo
.wav file from disk. Each control can be manipulated to give the proper 
playback level for its channel. Audio from all of the sources is summed 
together, then controlled by a master playback control, indicated in Figure
on page page 31 and by the master playback icon  in Figure 1-11 on 
16. Finally, the audio output is sent to the Speaker and Line Out connec
on the workstation back panel.
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Windows Multimedia Audio Settings Panels

This section describes the audio settings available under the Windows 
Multimedia software environment, located on the following panels:

• Volume Control Panel

• Properties Panel for Playback Control

• Properties Panel for Record Control

• Recording Control Panel

• Advanced Controls for Microphone Panel

• Sound Selection Panel

Volume Control Panel

The Windows Volume Control panel, shown in Figure 2-2, controls 
playback volume. You can display it by double-clicking the small speake
icon  in the System Tray (located in the taskbar). You enable the sm
speaker icon by activating the Show Volume Control on the Taskbar check 
box in the Microsoft Multimedia Properties  panel (Start > Settings > 
Control Panel > Multimedia  > Audio Tab).

Figure 2-2 Windows Volume Control Panel
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The settings in the Microsoft Windows Volume Control panel reflect those 
in the Silicon Graphics Audio Control  panel, providing you with an alternate
means of controlling playback and recording levels. The set of controls t
your system uses depends on which controls you most recently set. If yo
bring up the Microsoft Volume Control panel while you have the Silicon 
Graphics Audio Control  panel running, you can see how they interact as y
change the settings on each.

In the panel, there are balance, volume, and mute controls for each aud
input, as well as an overall master control at the extreme left side of the pa

Properties Panel for Playback Control

At the bottom left of the Volume Control panel, it says SGI Sound Mixer, 
which refers to the device selected in the Mixer Device drop down box in the 
Properties panel. The Mixer Device is what is used to blend the audio from
various sources. The Properties panel, shown in Figure 2-3, is available 
under Options > Properties on the Windows Volume Control panel.

Figure 2-3 Properties Panel for Playback Control
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In this panel, if you activate the Playback radio button, you can check one o
more of the devices listed in the lower area of the panel for which controls
the Volume Control panel will be available. If a box is not checked, contro
for the corresponding sound source are not displayed on the Volume Control 
panel (Figure 2-2).

Properties Panel for Record Control

You can display the Properties panel that controls audio recording by 
choosing Options > Properties on the Windows Volume Control panel. You 
must also activate the Recording radio button, as shown in Figure 2-4.

Figure 2-4 Properties Panel for Record Control

As shown, you can check the sound source from which you wish to reco
When you click OK , the Windows Recording Control panel is brought up, 
as shown in Figure 2-5.
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Figure 2-5 Recording Control Panel

This panel allows you to set up the balance and record levels for the dev
you have selected. 

When you click the Advanced button, the Advanced Controls for 
Microphone panel appears, shown in Figure 2-6.
36   Chapter 2



or 
Figure 2-6 Advanced Controls for Microphone 

Use the Tone Controls section of the panel to adjust the bass and treble f
the microphone.

Note: The Silicon Graphics audio driver does not support the tone 
controls. As a result, they are deactivated (gray).

Activate the Enable 20dB Mic Boost check box in the Other Controls 
section of the panel to increase the microphone sensitivity.
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Sound Selection Panel

The Sound Selection panel is shown in Figure 2-7.

Figure 2-7 Sound Selection Panel

You can display the Sound Selection panel by selecting Options > Audio 
Format... in the VidCap application. Use this panel to set up the wave dev
in the Name drop-down box and determine the quality of the sound to be
recorded. 

Name Drop-Down Box

Under the Name drop-down box, you must choose the desired sound qual
The choices are:

• CD Quality

• Telephone Quality

• Radio Quality

Choose the audio quality that corresponds to the target medium.

Format Drop-Down Box

Under the Format drop-down box, the only available choice is PCM (pulse 
code modulation).
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Attributes Drop-Down Box

Under the Attributes  drop-down box, the following sampling rate choices
are available, along with their corresponding data rates:

• 44.100 kHz, 16 bit, Stereo, 172 Kb/sec

• 48.000 kHz, 8 bit, Mono, 46 Kb/sec

• 48.000 kHz, 8 bit, Stereo, 93 Kb/sec

• 48.000 kHz, 16 bit, Mono, 93 Kb/sec

• 48.000 kHz, 16 bit, Mono, 187 Kb/sec

In general, the following sampling rate guidelines apply for digital audio 
sound recording quality:

• Telephone—8 kHz

• Radio—16 kHz

• Compact Disk (CD)—44.1 kHz

• Digital Audio Tape (DAT)—48 kHz

The sampling rate you choose determines the rate at which the worksta
analog to digital converters (ADCs) sample and digitize the incoming ana
audio.

The sampling rates are based on fulfilling the Nyquist criterion, which 
requires sampling at twice the maximum analog frequency. The maximu
frequency varies according to the medium transmitting the audio. The 
bandwidth of telephone audio is limited to about 4 kHz, so the telephone
quality sampling rate is 8 kHz. However, CD and DAT audio are high qua
and have sampling rates above 40 kHz. These rates approach the frequ
limit of human hearing, which is around 20 kHz. 

The 44.1 kHz rate seems a little odd—you might wonder why a simple r
of 40 kHz was not adopted. The main reason for this is that in the early d
of digital audio research, the necessary bandwidth of about 1 Mbps per a
channel was difficult to store. Disk drives had the bandwidth but not the 
capacity for long recording time, so attention turned to video recorders, wh
were adapted to store audio samples by creating a pseudo-video wavef
that conveyed binary as black and white levels. 
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The sampling rate of such a system is constrained to relate simply to the 
rate and field structure of the television standard used, so that an intege
number of samples can be stored on each usable TV line in the field. Su
recording can be made on a monochrome recorder, according to the NT
and PAL standards: 525 lines at 60 Hz and 625 lines at 50 Hz. It is possib
find a frequency that is a common multiple of the two and is also suitable
use as a sampling rate that is twice the maximum analog frequency. 

The allowable sampling rates in a pseudo-video system can be deduced
multiplying the field rate by the number of active lines in a field (blanking
lines cannot be used) and again by the number of samples in a line. By ca
choice of parameters it is possible to use either 525/60 or 625/50 video 
a sampling rate of 44.1KHz. 

In 60 Hz video, there are 35 blanked lines, leaving 490 lines per frame or
lines per field, so the sampling rate is given by:

60 X 245 X 3 = 44.1 kHz 

In 50 Hz video, there are 37 lines of blanking, leaving 588 active lines p
frame, or 294 per field, so the same sampling rate is given by:

50 X 294 X 3 = 44.1 kHz. 

The sampling rate of 44.1 kHz came to be used for compact disc audio. E
though a CD player has no video circuitry, the equipment used to make 
masters is video-based and determines the sampling rate. 

Digital audio tape tapes (DATs) use a sampling rate of 48 kHz. It has be
claimed that their sampling rate differs from that of CDs to make digital 
copying from one to the other more difficult. The rate of 48 kHz is, in 
principle, better because it is a multiple of the other standard sampling ra
namely 8 kHz and 16 kHz for telephone-quality audio. Sampling rate 
conversion is simplified if rates are integer multiples of each other. 

Choose the sampling rate most appropriate for the equipment used in yo
recording environment. You may use the Save As... button to save the S
Selection panel choices to a file that will appear in the Name drop-down 
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QuickTime Audio Settings Panels

This section describes the audio settings available under the Apple 
QuickTime Multimedia software environment, which are:

• Sound Compression Panel

• Sound Sample Control Panel

• Sound Source Control Panel

Sound Compression Panel

The QuickTime Sound Compression panel is shown in Figure 2-8.

Figure 2-8 Sound Compression Panel

You can display this panel under the HackTV application by selecting 
Monitor  > Sound Settings, then selecting Compression in the drop-down 
box of the Sound panel. This panel allows you to set the audio compress
algorithm, control the speaker operation, and adjust the recording audio
volume and gain.
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Compression

The compression algorithms available are the following:

• MACE 3:1

• MACE 6:1

• Qualcomm Pure

• ALaw 2:1

• 32-bit Floating Point

• 64-bit Floating Point

• IMA 4:1

• 24-bit Integer

• 32-bit Integer

• µLaw 2:1

More information about these QuickTime compression options can be fo
on the Apple Web site at www.apple.com/quicktime.

Speaker Operation

The Speaker drop-down box allows you to control the speakers with the 
following choices:

• Off—mutes the workstation speaker output

• On—enables the workstation speaker output

• Off While Recording—mutes the workstation speaker output while 
recording is in process. This is useful in eliminating feedback when y
are recording from a microphone.

Volume and Gain Controls

Two sliders, Volume and Gain, allow you to control the recording level.
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Sound Sample Control Panel

The QuickTime Sound Sample panel is shown in Figure 2-9.

Figure 2-9 Sound Sample Panel

You can display this panel under the HackTV application by selecting 
Monitor  > Sound Settings, then selecting Sample in the drop-down box of 
the Sound panel.

Sample Rate

Use the C-Rate drop-down box to set up the audio sampling rate. The 
available rates are:

• 11 kHz

• 22 kHz

• 44 kHz

The audio sampling rate choice determines the rate at which the worksta
analog to digital converters (ADCs) sample and digitize the incoming ana
audio. The higher the rate, the higher the sound quality.

Size

Use the Size buttons to choose the bit size of the samples.
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Use

Use the Use buttons to choose mono or stereo audio.

Sound Source Control Panel

The QuickTime Sound Source panel is shown in Figure 2-10.

Figure 2-10 Sound Sample Panel

You can display this panel under the HackTV application by selecting 
Monitor  > Sound Settings, then selecting Source in the drop-down box of 
the Sound panel.

This panel allows you to set up the source for audio recording. The Built-in  
device is the integrated audio support available with the workstations. As
add more support for audio, such as the Silicon Graphics DA1100 Digita
Audio Card, the Device and Input  windows reflect more choices. 
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Silicon Graphics Audio Control Panels

This section describes the audio programs available from the Silicon 
Graphics System Tray icon, which are:

• Audio Control Panel

• Digital Audio Control Panel (Silicon Graphics DA1100 Digital Audio 
card installed)

• Digital Audio Meter Panel (Silicon Graphics DA1100 Digital Audio 
card installed)

Audio Control Panel

The Silicon Graphics Audio Control  panel is shown in Figure 2-11.

Figure 2-11 Silicon Graphics Audio Control Panel

Master volume control

Audio CD

Microphone

Line In

Wave
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The basic functions of this panel were explained in “Capturing Video Us
VidCap” on page 11. More detailed functions are explained in this sectio

The Silicon Graphics Audio Control  panel, shown in Figure 2-11, provides
you with a set of mixer controls that governs audio input and output volu
and that selects the input line. The controls set volume levels from the 
different sources, allowing you to “mix” sounds together.

The Volume Control panel has three sections: 

• Play Control

• Record Control

• Wave Input. 

The Play Control section contains the line-enable checkboxes, volume 
controls, and balance controls for each input line that can be mixed into 
audio output, as well as the master volume control. The Record Control 
section contains the recording-enable check boxes, gain control, and ba
control for each line. The Wave Input displays a graphic representation of th
frequency content of the input in either two or three dimensions.

You adjust the volume for playback or recording by raising or lowering th
vertical sliders under or next to the icons that represent the lines. You ad
the right-left balance of the audio by moving the horizontal sliders under
volume controls.

Note: The Audio Control  panel preserves the settings you choose for 
the various source options unless you change the settings with 
another audio control mechanism, such as the Windows 
Volume Control panel.

The Audio Control  panel also shows right and left stereo audio levels 
through use of dynamic display meters in the Play Control and Record 
Control  sections.

Playback Functions

To mute or enable listening to a line, click the On box below the slider bars 
for the line. Each input can be independently controlled. Change the liste
volume or left-right balance with the associated slider controls.
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Record Functions

In the Record Control section, you can choose CD, microphone, and line
sources, and you can record a currently playing .wav file. Only one line can 
be selected at a time for recording by clicking the button to the left of the 
icon next to the slider bar. Use the volume and balance sliders to adjust
record settings. Adjust the record slider so that the audio levels indicate
the Record Control panel are as high as possible without clipping (red 
region). Be sure to close the Wave Input panel before you actually start 
recording— otherwise the wave input remains unavailable and recording
does not take place.

Note: The Record Control panel does not actually record audio. You 
must use a multimedia application such as HackTV for 
QuickTime or VidCap for Windows.

File Pulldown Menu

Use the File pulldown menu to exit the audio control panel. You can also en
Ctrl+Q  to exit.

When you exit the Silicon Graphics Audio Control  Panel, your system saves
the audio settings you selected. These settings stay in effect until you ch
them using either the Silicon Graphics Audio Control  Panel or other audio 
control software, such as Microsoft Windows audio controls.

Options Pulldown Menu

Use the Options pulldown menu to control the display of the Silicon 
Graphics Audio Control  panel Wave Input. Below is a list of the menu 
choices available in the Options pulldown menu and a brief description of 
how to use them.

• Show Wave Input (Ctrl+S)—displays the dynamic frequency content
of the audio input.

• Show Record Controls (Ctrl+R)—enlarges or diminishes the display 
of the control panel to show or hide the recording controls.

• Freeze Graphics (Ctrl+G)—use this option to stop the motion of the 
level meters and the wave input display.
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• Enable 20dB Mic Boost—use this option to increase microphone 
sensitivity.

• Solid Meters (Ctrl+M)—use this option to change the display of the 
double vertical audio input and output level meters (to the right of th
play and record sections). When you enable this option, the bars cha
to solid bands of different colors.

• Log Amplitude (Ctrl+A)—changes the sensitivity of the spectral 
display.

• 3D Spectrum (Ctrl+D)—changes the spectral display from a series o
vertical colored bars (2D) to a moving color display (3D).

• 3D Options—changes the manner in which the 3D spectrum display
For example, you can make the 3D spectrum draw vertical lines (Dr
Lines), draw a series of dots (Draw Points), or display a series of 
triangles (Draw Triangles). The following list details the 3D options:

• Reverse View (Ctrl+V)—flips the Wave Input display 180 degrees

• Draw Mesh (Ctrl+H)—shows the wave input as a web of colored
lines.

• Draw Time Lines (Ctrl+L)—displays the wave input as a sequenc
occurring over a period of time. The lines run from the front to ba
of the display. This display resembles the mesh display, but with
the horizontal lines.

• Draw Frequency Lines (Ctrl+U)—displays the wave input as a 
series of lines that run from left to right in the display. Each line 
represents the frequency content of a time-slice of the signal.

• Draw Points (Ctrl+P)—shows Wave Input display as a series of 
dots instead of lines.

• Draw Triangles (Ctrl+T)—displays the wave input as solid colors

• Log Frequency (Ctrl+F)—shows more detail at the lower 
frequencies and less detail at the higher frequencies.

• Audio/Video Sync—choosing this option brings up the screen 
shown in Figure 2-12. Use this screen to choose the video signa
source that will be used to synchronize audio.
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Figure 2-12 Audio/Video Sync Panel

A check mark appears next to each of the enabled options on the Options 
pulldown menu.
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Digital Audio Control Panel (Silicon Graphics DA1100 
Digital Audio Card Installed)

When the Silicon Graphics DA1100 Digital Audio Card is installed, you c
bring up the Silicon Graphics Digital Audio Control panel by clicking the 
Silicon Graphics icon in the Windows System Tray and selecting Digital 
Audio Control Panel. The panel is shown in Figure 2-13.

Figure 2-13 Silicon Graphics Digital Audio Control Panel

For a detailed explanation of this panel see the Silicon Graphics DA1100 
Digital Audio Card Owner’s Guide.
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Digital Audio Meter Panel (Silicon Graphics DA1100 
Digital Audio Card Installed)

When the Silicon Graphics DA1100 Digital Audio Card is installed, you c
bring up the Silicon Graphics Digital Audio Meters panel by clicking on the 
Silicon Graphics icon in the Windows System Tray and selecting Digital 
Audio Meter Panel. The panel is shown in Figure 2-14.

Figure 2-14 Silicon Graphics Digital Audio Meter Panel

For a detailed explanation of this panel see the Silicon Graphics DA1100 
Digital Audio Card Owner’s Guide.
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Software Synthesizer and MIDI Support

This section explains how to use the Yamaha S-YXG50 software wave t
synthesizer software and MIDI Player with the Silicon Graphics 320 and
Silicon Graphics 540 workstations. The Yamaha software synthesizer and
Yamaha MIDI player application are separate entities. The software 
synthesizer is a driver that provides a system service to other applications
MIDI player is an application that plays MIDI files through the software 
synthesizer driver.

The S-YXG50 software wavetable synthesizer software supports up to 1
simultaneous voices at 44 kHz and supports Yamaha XG MIDI format, th
most popular MIDI format in the music industry.

The Yamaha S-YXG50 Software Synthesizer allows you to play back MI
song files on your computer without using a hardware tone generator. Its 
fidelity sounds, which match the sounds from an authentic tone generator
based on and realized by highly advanced MMX technology. The S-YXG
synthesizer lets your workstation act as a potential music synthesizer.

Because the hardware audio codec on the workstation does not come w
MIDI synthesis capability, the Yamaha software wave table synthesizer i
bundled with the system.

Features

The Yamaha Software Synthesizer S-YXG50 software wave table featur
are as follows:

• Professional sound quality (44-kHz sampling rate).

• YAMAHA XG format compatible, with a variety of controllable effects

• Simultaneous playback of wave and MIDI data.

• Driver application for Windows that is not dependent on specific 
CODEC hardware.

• Performance can be matched to a wide range of applications (44 kH
kHz/11 kHz sample rate switching).

• Designed specifically for use with MMX technology.

• DirectSound support.
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Software Synthesizer

Figure 2-15 shows the main synthesizer settings panel.

Figure 2-15 Software Synthesizer Panel

This panel may be used to set the number of voices (polyphony), allowa
CPU load, special sound effects, sampling rate, and DirectSound (for 
DirectSound-compatible games). The panel is fully described in the help 
that come with the Yamaha software.
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MIDI Player

Figure 2-16 shows the MIDI player panel.

Figure 2-16 MIDI Player Panel

The Yamaha MIDI player can be used as an alternative to the Windows M
Player for playing MIDI files. The panel is fully described in the help files
that come with the Yamaha software.

Confi guration

Silicon Graphics provides a scheme in which the software synthesizer sh
the hardware codec audio output with a wave output device. This is esse
for providing simultaneous sound from both game and MIDI outputs. Th
are two ways to share the codec and wave output device:

• Use DirectSound

• Use the Yamaha Special Wave Device

DirectSound

If you are running an application that is DirectSound compatible (many 
Windows games are), Microsoft’s DirectSound layer allows the Yamaha 
software synthesizer to share the audio output hardware with one or mo
wave audio outputs from the application. 

You must manually configure the Yamaha synthesizer for DirectSound 
operation—but then non-DirectSound applications can no longer produc
sound. By default, the Yamaha Software Synthesizer is not configured fo
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DirectSound operation when you first operate the Silicon Graphics 320 o
Silicon Graphics 540 workstation.

Yamaha Special Wave Device

Yamaha provides a special Wave Output device for their synthesizer tha
shows up in the Windows NT Multimedia Properties Audio tab (under 
Playback Devices). If you select this as the default Playback device instea
the SGI Sound device, then Yamaha’s driver intercepts Wave Output from
application and redirects it through their driver so that the synthesizer ou
can be mixed in along with the Wave Output samples.

This net effect is equivalent to that provided by a PC sound card: one M
file and one Wave file can be played at the same time, and the sounds f
the two are mixed together in hardware. This is the default configuration
the Yamaha synthesizer “out of the box.” However, Yamaha's “intercepto
driver seems to degrade latencies for Wave audio playback, so it is not t
output device of choice for video editing and layback to tape, for exampl

Recommendations

You may want to use either of the two configurations just explained, 
depending on what application is running. Also, the system may need to
restarted between configuration changes.

Yamaha's on line documentation and help files include some explanatio
about where to configure DirectSound versus Wave Out operation. See 
Yamaha documentation included in the help files for all the control pane
settings (numbers of voices, sample rate, and so forth).
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Chapter 3

3. Capturing and Playing Video with VidCap and 
Video for Windows

This chapter explains the details of the various panels and dialog boxes
encountered when capturing and playing back video using the VidCap 
application and Video for Windows. The basic process of capturing video 
explained in Chapter 1, “Getting Started.”

This chapter discusses the following topics:

• “Video for Windows Capture Settings” on page 58

• “Silicon Graphics Video Control Screen” on page 69
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Video for Windows Capture Settings

The capture settings are available under the main VidCap window. To br
up this window, double-click the VidCap32.exe icon, located at 
C:\WINNT\SYSTEM32. The main VidCap screen appears, as shown in 
Figure 3-1.

.

Figure 3-1 VidCap Main Screen

Under the Options menu of the VidCap main screen, there are three choice
dealing with video: Video Format, Video Source, and Video Display. Each 
choice takes you to the Silicon Graphics VFW Capture Settings screen, 
shown in Figure 3-2.
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Figure 3-2 Silicon Graphics VFW Capture Settings Screen

The Silicon Graphics VFW Capture Settings panel lets you configure 
several settings before capturing video. As shown in the figure, the scree
divided into several sections and contains several buttons. Each is expla
in the following subsections.
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Source Jack

The Source Jack section of the panel lets you set up video capture for a 
particular video input jack. You can adjust the settings in all of the other 
sections of the panel, click OK , and those settings are applied to and 
remembered for that jack. The available jacks are:

• Composite In

• S-Video In

• Serial Digital 1 In (the Silicon Graphics SD1100 Serial Digital Video 
Interface Board1 #1 must be installed)

• Serial Digital 2 In (the Silicon Graphics SD1100 Serial Digital Video 
Interface Board1 #2 must be installed)

Source Timin g

You must set up the buttons in the Source Timing section to match the video
timing standard of the video you wish to capture on a particular jack. The 
choices are:

• NTSC (the video standard used in North America)

• PAL (the video standard used most everywhere else)

Other Settin gs

Clicking the Dither Images check box applies dithering to the captured 
image. This check box is active only for capturing in the 16-bit RGB form

Dithering is an image display technique that is useful for overcoming limi
display resources. The word dither refers to a random or semi-random 
perturbation of the pixel values. Two applications of dithering are particula
useful: 

1 The board is only available on the 540 workstation.
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• Low quantization display. When images are reduced to just a few bi
only a limited number of gray levels are used in the display of the 
image. If the scene is smoothly shaded, then the image display gene
distinct boundaries around the edges of image regions, degrading th
quality of the image. To eliminate this effect, dithering adds random 
noise (with a small range of values) to the original signal to mask th
limited color range. The result is a smoother image captured to disk

• Limited color display. When fewer colors are able to be displayed (fo
example, 256) than are present in the input image (for example, 24-
color), then dithering causes patterns of adjacent pixels to simulate 
appearance of the unrepresented colors.

Color Settin gs

The Color Settings sliders interact with the sliders found on the Color tab of 
the Silicon Graphics Video Control screen (see Figure 3-7). When you 
move a slider on one of the screens, the corresponding slider moves on
other screen. Although you can visually detect changes as you move the
sliders, it is best to use test equipment to monitor the S-Video or compo
output as you make adjustments to make certain that the colors are prop
adjusted. In monitoring and controlling picture quality two pieces of 
equipment are essential. The first is the waveform monitor, which graphic
displays and measures the brightness or luminance level of the video. T
second is the vectorscope, which measures the color (chroma) informat
Although these are generally separate instruments, in some cases both c
displayed on a single TV monitor or computer editing screen.

The numeric values in the boxes to the right of each slider are relative 
numbers only, and can serve as reference numbers you may want to reco
later restoration of particular color setting configurations.

There are four Color Settings sliders in the Silicon Graphics VFW 
Windows Settings panel:

• Brightness—changes the brightness of the video.

• Contrast—changes the ratio of luminance (brightness) between the 
lightest and darkest elements of a video scene. Contrast ratio is a m
determinant of perceived picture quality and sharpness.
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• Saturation—changes the degree of colorfulness, from neutral gray 
through pastel to saturated colors.

• Hue—changes the color perception denoted by blue, green, red, yel
and so on. 

Note: You cannot adjust color settings for digital video input sources. 
The Color Settings sliders are grayed out if you have one or 
more Silicon Graphics SD1100 Serial Digital Video Interface 
Boards installed and activate the Serial Digital 1 In or Serial 
Digital 2 In  radio button on the Silicon Graphics VFW 
Windows Settings panel.

Captured AVI File Settin gs

The Captured AVI (Audio Video Interleave) File Settings section lets you 
control pixel size, image size, and video compression.

Pixel Aspect Ratio

Picture aspect ratio is the width of the picture divided by the height. There
two choices available for pixel aspect ratio:

• Square—used for video on computer monitors

• CCIR601—used for high-end video production and display on video
monitors

Pixel aspect ratio is defined as the pixel height divided by its width. For 
example, in Figure 3-3, the pixel represented on the left is square, with a p
aspect ratio of 1.0; the one on the right is non-square, with a pixel aspect 
of 1.125.

.

Figure 3-3 Pixel Aspect Ratio
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The choice of square or CCIR601 (non-square) for the pixel aspect ratio
depends on the source providing the video and how the video will be 
displayed.

Video sampling and digitizing inside the workstations always produces 
CCIR601 non-square pixels from analog video input. If you activate the 
Square radio button, the workstation performs additional processing in 
hardware to convert from square to CCIR601 pixel format. 

All digital video sources, such as the Silicon Graphics DV100 Serial Digi
Video Card, supply video in non-square pixel format. When you use a dig
video source, there is no need to sample the video and create pixels—th
video is already in digital form and the pixel content is defined to be 
non-square according to the CCIR601 standard. However, you can still 
convert the pixels to square format by activating the Square radio button

If you choose to capture video from one of the analog inputs (composite
S-Video), the hardware in the workstation uses an ADC to digitize the vid
and additional hardware processing creates non-square pixels. Square p
are produced from the non-square pixels if you check the Square radio bu

In general, graphics rendering and display devices typically generate an
accept only square pixels, but video I/O devices can typically generate a
accept either square or non-square formats. It is preferable to use and re
non-square format for an application whose purpose is to produce video
while it is preferable for an application whose ultimate intent is producing
computer graphics to use and retain a square format. Whether a convers
necessary or optimal depends on the original image source, the final 
destination, and, to a certain extent, the hardware path transporting the s

A diagram showing the timing associated with CCIR601 digital video is 
shown in Figure 3-4.
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Figure 3-4 CCIR601 Timing

The CCIR standard applies to both NTSC and PAL video. In NTSC, two
vertical fields are completed 30 times per second (every 33.33 ms), with e
scan filling one-half of the 525 vertical lines. So it takes 16.67 ms to comp
each field. The horizontal scan time is calculated by the following equati

Horizontal scan time = 16.67 ms/(525 lines/2) = 63.5 µs. Of the 63.5 µs, 53 
µs are actually used for video data. The CCIR601 standard specifies tha
analog video be sampled at 27 MHz, with each sample being 8-bit PCM
a sampling rate of 27 MHz, 1440 samples fit into the 53 µs period. With 
CCIR601 4:2:2 sampling (see Figure 3-4), there are 720 luminance (Y) 
samples, 360 red color difference (R-Y) samples, and 360 blue color 
difference (B-Y) samples, for a total of 1440 samples per line.

Image Size

The Image Size drop-down box lets you choose different image sizes for bo
square pixels and CCIR601 pixels. To keep the image resolution constan
picture size must be reduced when there are fewer pixels in the picture.
image size that you choose affects the bit rate, as shown in Table 3-1.
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Table 3-1 shows a list of common frame sizes, pixel formats, and associ
data rates. 

The data rate numbers in the table include video frame capture as well a
two-channel 44.1 kHz CD-quality audio.

When you activate the Square Pixel Aspect Ratio button, the following 
image sizes appear in the drop-down box:

• 640 x 480

• 320 x 240

• 160 x 120

• 80 x 60

All of these choices have the same picture aspect ratio, 1.333.

When you activate the CCIR601 Pixel Aspect Ratio button, the following 
image sizes appear in the drop-down box:

• 720 x 480

• 360 x 240

• 180 x 120

• 88 x 60

Because the pixels are non-square, these choices, too, have a picture a
ratio of 1.33.

Table 3-1 Common Video Parameters

Frame Size Video Standard Pixel Format Data Rate (MB/sec)

640 x 480 NTSC 2YUV 18.1

720 x 486 NTSC 2YUV 20.6

720 x 576 PAL 2YUV 20.4

768 x 576 PAL 2YUV 22.2

640 x 480 NTSC RGBA 36.1

720 x 486 NTSC RGBA 41.1

720 x 576 PAL RGBA 40.6

768 x 576 PAL RGBA 43.3
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When using an image size of 640 x 480 made up of square pixels, the pi
aspect ratio is 640/480 = 1.333. Now, if you keep the same ratio, and cre
picture with CCIR601 sampling (for example, 720 x 480), you have 720 
pixels in the same horizontal width that formerly held 640 pixels, so the pix
have a shorter horizontal length, but have the same vertical length, sinc
number of lines (480) is the same in both cases. Therefore, the pixels bec
non-square. See Figure 3-5.

.

Figure 3-5 1.333 Picture Aspect Ratio with Square and CCIR601 Pixels

Image Format

The Image Format drop-down box and the associated buttons (Quality, Bit 
Rate, and Use Software Codec) deal with video compression. This topic is
fully covered in Chapter 5, “Silicon Graphics Video Compression 
Techniques.”

Restore Defaults Button

The Restore Defaults button allows you to restore the default settings in th
Silicon Graphics VFW Windows Settings panel. The button is especially 
helpful in restoring the color settings, which can easily be misadjusted w
you change the sliders without monitoring the results with professional t
equipment.
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Video Out Button

The Video Out button allows you to configure the video out of the 
workstation on the analog or digital video connectors. When you click Video 
Out, the screen shown in Figure 3-6 appears.

.

Figure 3-6 Silicon Graphics VFW Output Settings Screen

Output Jack

The Output Jack radio buttons let you choose one video connector for outp
video.

Note: Unless you have one or more Silicon Graphics DV100 Serial 
Digital Video Cards plugged in, the SerialDigital 1 Out and 
SerialDigital 2 Out radio buttons are grayed out.

Output Timing

The output video is selectable between NTSC and PAL . The NTSC standard 
specifies 525 lines per frame, with two fields per frame of 262.5 lines ea
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Each field refreshes at a rate of 29.97 Hz. The NTSC standard specifies
lines per frame, with two fields per frame of 312.5 lines each. Each field
refreshes at a rate of 25 Hz. 

Activating an Output Timing button does not mean that the workstation 
converts input video from one timing to the other (for example, NTSC to
PAL). Rather, you should match the Source Timing buttons in the Silicon 
Graphics VFW Windows Settings panel to those of the Output Timing  
section in the Silicon Graphics VFW Output Settings panel. To output an 
already captured video file, you should first determine the video standar
(NTSC or PAL) of the file, then choose the corresponding Output Timing  
button in the Silicon Graphics VFW Output Settings panel.

Square to Non-Square Conversion

If you have captured analog video with the Square button activated on the 
Silicon Graphics VFW Windows Settings panel, and you need to output the
video to a device that requires non-square pixels, you must activate the 
Square to Nonsquare Conversion check box. With this check box active, an
NTSC image will become larger (from 640 to 720), and a PAL image beco
smaller (from 768 to 720).

Enable Video Display on Computer Screen

Checking this box allows video to be displayed on the computer monitor. T
may not take effect until you restart the computer. 
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Silicon Graphics Video Control Screen

To bring up the Silicon Graphics Video Control screen, click on the Silicon 
Graphics icon in the System Tray and choose Video Control Panel. The 
panel appears, as shown in Figure 3-7.

.

Figure 3-7 Silicon Graphics Video Control Screen

As shown in the figure, the panel has these sections:

• Select Jack to Control

• Tabs (Color, Sharpness, Timing, Gain, and Misc)

In addition to these controls, these choices under the File menu are discussed
here:

• Restore Default Settings for This Jack

• Graphics Display Framelock

The other choices under the File menu and the Edit  and Help menus are 
self-evident, and not discussed here.
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Select Jack to Control

The top five radio buttons in the Select jack to Control section correlate to
input jacks, and the bottom four correlate to the output jacks. When you
choose a particular input or output jack (only one may be chosen at a tim
you can use the Color, Sharpness, Timing , Gain, and Misc tabs to configure 
that jack. The settings available on the tab panels often depend on which
has been activated. Some of the settings may be grayed out, depending
whether you selected an input jack or output jack. The settings you choos
saved for the selected jack and remain in effect until you change them. I
not necessary to have a video cable plugged into a jack to configure its 
settings.

IComposite In

The Composite In radio button, when activated, allows you to configure th
settings for the Composite video input. An asterisk beside the Composite In 
radio button indicates that there is an active video signal at the jack.

S-Video In

The S-Video In radio button, when activated, allows you to configure the 
settings for the S-Video input. An asterisk beside the S-Video In radio button 
indicates that there is an active video signal at the jack.

Serial Digital In (1, 2)

These jacks are grayed out unless you have the corresponding Silicon 
Graphics DV100 Serial Digital Video Card plugged into the Silicon Graph
540 workstation. If a Digital Video Card is plugged in, an asterisk beside 
name of the card indicates that there is an active signal at the jack. Whe
buttons are enabled, checking them allows you to configure the settings
the corresponding digital video input.

Reference In

The Reference In radio button is grayed out unless a Silicon Graphics 
SD1100 Serial Digital Video Interface Board is installed. When this radio
button is activated, you may connect a “house sync” clock synchronizati
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signal to the Serial Digital Interface Board “Ref Vid In” jack. The signal o
the jack synchronizes output signals from the Silicon Graphics 540 
workstation. Studio houses typically have a single synchronization signa
which all the equipment is slaved.

Composite Out

The Composite Out radio button, when activated, allows you to configure
the settings for the Composite video output.

S-Video Out

The S-Video Out radio button, when activated, allows you to configure th
settings for the S-Video output.

Serial Digital Out (1,2)

These jacks are grayed out unless you have the corresponding Silicon 
Graphics DV100 Serial Digital Video Card plugged into the Silicon Graph
540 workstation. When the buttons are enabled, checking them allows yo
configure the settings for the corresponding digital video output.
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Color Tab

When the Color tab is selected, the sliders that are available depend on t
jack selected. When an input jack is selected, the Brightness, Contrast, 
Saturation, and Hue sliders are available, as shown in Figure 3-8. 

.

Figure 3-8 Color Tab for Input Jacks

When an output jack is selected, the Black Level, Blank Level, H Phase, and 
Color Burst  sliders are available, as shown in Figure 3-9.
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Figure 3-9 Color Tab for Output Jacks

It is highly recommended that you use professional test equipment when
changing the sliders on the Color tab. The reason is that it is difficult to see
subtle changes in the color settings with the naked eye, and the perceiv
color depends to a large extent on the quality and calibration of the disp
mechanism (TV or computer monitor).

Brightness, Contrast, Saturation, and Hue Sliders 
(input jacks)

• Brightness—changes the brightness of the video.

• Contrast—changes the ratio of luminance (brightness) between the 
lightest and darkest elements of a video scene. Contrast ratio is a m
determinant of perceived picture quality and sharpness.

• Saturation—changes the degree of colorfulness, from neutral gray 
through pastel to saturated colors.

• Hue—changes the color perception denoted by blue, green, red, yel
and so on. 
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Black Level, Blank Level, H Phase, Color Burst Sliders 
(output jacks)

• Black Level—adjusts the offset of the red, blue, and green elements
presented on the display. The black level is related to bias, which se
the reference level for a color scale. Figure 3-4 shows the typical tim
diagram for a horizontal scan line. The blackest portion of the picture
represented by the amplitude of the black level. If the black level is t
low, the picture has compressed blacks. The resulting video is too d
without any detail in the dark areas, and a gray scale reproduces wi
loss of separation between the darkest divisions of the scale. On the
other hand, if the black level is too high, the video looks overexposed
washed out. The ideal setting for the black level results in a uniform
distribution of colors with no clipping at the white level and no mergin
of the blacker levels of the picture.

• Blank Level—in the timing for the horizontal scan line, at the 
beginning of the line, the amplitude below the black level contains 
important timing signals referred to as sync, which is short for 
synchronizing pulses. These are the high-speed timing pulses that k
all video equipment “in lock step” during the process of scanning lin
fields, and frames. These pulses dictate the precise point that the 
electronic beam starts and stops while scanning each line, field, and
frame. In fact, without these pulses, electronic chaos would instantly
break out between pieces of video equipment. A single source of sy
from an electronic device called a sync generator supplies a commo
timing pulse for all equipment that must work in unity within a 
production system or facility. If the sync timing extends too long, the
black level of the video is pushed too high (graying out the picture); 
the sync timing is too short, the black level cuts into the sync and th
picture rolls and breaks up. The blanking signal (sometimes called 
pedestal or set-up) occurs just before the color burst and needs to b
kept at the proper level to maintain proper blacks and to ensure that
strange diagonal lines do not appear in your video.

• H Phase—adjusts the phase of the encoded color subcarrier (includi
burst) relative to horizontal sync. It can be adjusted in steps of 360/2
(1.406) degrees.

• Color Burst—adjusts the amplitude of the color burst signal, which 
indicates whether video equipment is generating a basic color timing
signal. It consists of 8 to 11 cycles of 3.58 MHz color subcarrier and
occurs during the horizontal pulse just after the blanking signal and 
before the actual color content of the signal (the area known as the 
“back porch”).
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Sharpness Tab

You must choose an input jack before the controls are active in the Sharpness 
tab. If you choose an output jack, the controls are grayed out. The Sharpness 
tab panel is shown in Figure 3-10.

.

Figure 3-10 Sharpness Tab (Input Jacks Only)

Aperture Bandpass

You can peak the higher frequencies of the luminance signal by running
signal through a bandpass filter. The filtered signal is weighted by an 
Aperture Factor (see next section) and added to the original unfiltered 
signal, boosting the frequencies passed by the filter. The Aperture Bandpass 
control selects the center frequency of the bandpass filter. 

The choices for Aperture Bandpass are 4.1 MHz, 3.8 MHz, 2.6 MHz, or 2.9 
MHz . Each choice represents a different center frequency. Changing thi
selection affects only the luminance portion of the picture. When you loo
TV broadcast information with a spectrum analyzer, you see that there a
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packets of information every 15 kHz. Luminance (the black and white par
the picture) starts at 15 kHz, with the next packet is at 30 kHz, and so on
Chrominance (color) information also occurs every 15 kHz, but is 
interleaved, starting at 7.5 kHz. To deinterleave the luminance and 
chrominance information, a comb filter is normally implemented. A comb
filter acts every 15 kHz to extract the packets. All packets are contained
within a 4.2 MHz band for a single channel. Because the Silicon Graphic
workstations do not implement a comb filter, they implement a filter that ro
off the luminance before the chrominance information is encountered. T
aperture corrector in the workstation hardware makes the picture look be
by selectively boosting a certain range of frequencies based on a center
frequency (the Aperture Bandwidth). Essentially, it is a sharpness 
mechanism. The Aperture Bandpass filter is a corrector that is adjustabl
you can pick the center frequency you are going to affect.

Aperture Factor

The Aperture Factor allows you to determine the amplitude contribution o
the frequencies you have chosen with the Aperture Bandpass control. The 
choices are:

• 0.0—no contribution

• 0.25—1/4 contribution

• 0.5—1/2 contribution

• 1.0—full contribution

Chroma Bandwidth

The choices for Chroma Bandwidth are 620 kHz, 800 kHz, 920 kHz, and 
1000 kHz. The numbers represent the bandwidth of the chrominance 
difference signals. The color difference signals are low-pass filtered to 
achieve the selected bandwidth.
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Timin g Tab

On the Timing  tab, the controls that are available depend on the jack selec
When an input jack is selected, the Signal Present, Jack Timing, and Color 
Standard Detect controls are available, as shown in Figure 3-11.

Figure 3-11 Timing Tab for Input Jacks
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When an output jack is selected, the Jack Timing, Genlock Source, and 
Genlock Delay controls are available, as shown in Figure 3-12.

.

Figure 3-12 Timing Tab for Output Jacks

Signal Present

The Signal Present buttons are active only when you choose an input jac
They indicate what type of signal, if any, is present at the jack. 

Jack Timing

When you have selected an input jack, activate the Jack Timing button that 
matches the timing of the input signal on that jack.

When you have selected an output jack, activate the Jack Timing button that 
corresponds to the timing you wish to output on that jack.
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Color Standard Detect

The Color Standard Detect drop-down box is active only when an analog
input jack is selected. It is grayed out if you choose the Serial Digital 1 In
Serial Digital 2 In jacks.

The choices are Not Applicable, PAL BGHI NTSC M  (the default 
standard), NTSC 443 PAL 443, PAL N NTSC 443, and NTSC N PAL M . 
The 443 in the nomenclature refers to the 4.43 MHz color subcarrier 
frequency. You should choose the color standard that nest matches the 
at the input source jack.

See Appendix A for more information about the NTSC and PAL standard

Genlock Source

The Genlock Source drop-down box is available only when you choose a
output jack. The Genlock device allows the output video to be synchroni
to a common frequency source. The choices for the Genlock Source are as 
follows:

• None—audio and video are not synchronized.

• Internal —the video output generates its own clock, which is not lock
to any video signal. 

• Composite In—the video synchronization signal is derived from the 
composite video in signal.

• S-Video In—the video synchronization signal is derived from the 
composite S-Video In signal.

Genlock Delay

The Genlock Delay slider is available only when you choose an output jac
It allows you to control the timing delay between the genlock source and
video output timing, which allows you to achieve genlock with other devic
in an editing suite. When you switch from one device to another, unless 
have all the sources genlocked and synchronized, you might see a blac
in the middle of the screen or bad color. 

The units of Genlock Delay are in units of CCIR clock cycles. When 
adjusting genlock, it is highly recommended that you use external test 
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equipment to line up the genlock delays from various pieces of equipme
There is typically one sync generator for an editing suite, but often each
individual piece of equipment must be individually adjusted.

Gain Tab

On the Gain tab, the controls and sliders that are available depend on the 
selected. When an input jack is selected, the Automatic Gain Control 
(AGC), Gain Hold, AGC Updates Every, YC Gain, C Gain, and Gain 
Hysteresis controls and sliders are available, as shown in Figure 3-13. 

.

Figure 3-13 Gain Tab for Input Jacks
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When an output jack is selected, the U Gain and V Gain sliders are available, 
as shown in Figure 3-13

.

Figure 3-14 Gain Tab for Output Jacks

Automatic Gain Control AGC Check Box

The Automatic Gain Hold (AGC)  check box is available only when you 
choose an input jack. When this box is checked, the workstation 
automatically compensates for level fluctuations in the input signal. Und
normal circumstances, the box should always be checked.

Gain Hold Check Box

The Gain Hold check box is available only when an input jack is selected
When you check it, the level of the signal attempts to remain constant as
picture content changes. If you want to freeze the gain, you can check th
Gain Hold check box on-the-fly when you have a gain level you want to 
maintain. When the Gain Hold check box is checked, it overrides the AGC 
check box.
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AGC Updates Every Line/Field Radio Buttons

This check box is available only when an input jack is selected. It specif
how often the AGC circuitry should look at and try to regulate the gain. If 
Line radio button is activated, the AGC circuit reevaluates the gain every
horizontal line. If the Field button is chosen, the gain is reevaluated ever
field (262.5 lines for NTSC, for example). The look of the picture change
with these two selections. When you choose Field, the gain is averaged over
the entire field before a decision is made to change the gain, so that 
high-contrast elements within a frame maintain their respective gains. If 
choose Line, and you have a picture with high vertical contrast situations, 
AGC can regulate the gain every line. In this situation, the contrast ratio
small, because the gain changes as soon as the picture gets darker or l
on a line-by-line basis, compared with doing a weighting over the whole fie
An empirical process is probably the best way to evaluate the selection 
AGC updates every field or line.

Color Gain Sliders

It is highly recommended that you use professional test equipment to prop
adjust the color gains. If the sliders are accidentally misadjusted, choose
File > Restore Default Settings to restore the slider settings for a particula
jack. The output and input sliders are completely independent. However
when making adjustments, adjust the output first with a test signal (use 
Output Test Colorbars check box in the Misc tab), then adjust the input 
sliders. Use test equipment to calibrate color saturation, brightness, and
forth. The following Color Gain sliders are available:

• YC Gain—applies to input jacks only, and is adjustable only when th
AGC check box has not been activated. The YC Gain slider adjusts 
both the Y and C gain of the composite video input, because Y and 
are combined onto the same signal (one wire). When adjusting S-Vi
gain, this slider applies only to the Y portion of the S-Video signal.

• C Gain—applies to input jacks only, and is adjustable only when the
AGC check box has not been activated. The C Gain slider adjusts the C 
portion of the gain of the S-Video input. The Y portion of the gain is 
adjusted with the YC Gain slider.

• U Gain—applies to output jacks only. The U Gain value affects the U 
color difference level.

• V Gain—applies to output jacks only. The V Gain value affects the V 
color difference level.
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The boxes to the right of the Color Gain sliders are in units of dB. They 
change as you adjust the sliders, or you may type into them directly. 

Gain Hysteresis Slider

The Gain Hysteresis slider applies only when an input jack is selected. Th
numbers in the boxes are relative numbers only. The actual gain must ch
by the Gain Hysteresis amount for the AGC circuitry to reevaluate the gain
A large Gain Hysteresis number results in slower AGC adjustments. A sma
number results in faster adjustments.

Misc Tab

On the Misc tab, the controls that are available depend on the jack selec
When an input jack is selected, the Vert Noise Reduction, Analog Process, 
Luma Delay, TV/VTR , Limit White Peak , and Fast Color Time controls 
are available, as shown in Figure 3-15. 

.

Figure 3-15 Misc Tab for Input Jacks
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When an output jack is selected, the Jack Carries and Output Test 
Colorbars controls are available, as shown in Figure 3-16.

.

Figure 3-16 Misc Tab for Output Jacks

Vertical Noise Reduction

The Vert Noise Reduction drop-down box is available only when an input
jack is selected. The purpose of this control is to determine how the vide
input responds to vertical noise in the video signal. Excessive noise can m
the picture roll or not lock up. The choices are:

• Normal

• Search

• Free Run

• Bypass

In all cases, choose Normal for Vertical Noise Reduction.
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Analog Process

The Analog Process drop-down box is available only when an input jack i
selected. Before A to D conversion, the analog signal can be amplified a
antialias filtered. The choices for Analog Process are:

• Not Applicable—no action

• Bypass—no action

• Amplify —amplify only

• Amplify Alias —amplify and perform antialias filtering

Luma Delay

The Luma Delay drop-down box is available only when an input jack is 
selected. The filters in the workstation hardware separate the Luma and
Chroma video components (see “Aperture Bandpass” on page 75). The
purpose of this control is to line up the Luma and Chroma components be
the signal is processed by the ADC converter. It is highly recommended 
you use professional test equipment to align the components. The Luma 
Delay choices, which are in units of 2 x CCIR video clock cycles, are:

• Not Applicable

• -4

• -3

• -2

• -1

• 0

• 1

• 2

• 3

TV/VTR

The TV/VTR  drop-down box is available only when an input jack is selecte
The purpose of this control is to compensate for VTR timing jitter resultin
from the slight variations inherent in an electromechanical systems. If yo
choose TV, you are assuming a stable input source. If you use a VTR as
Capturing and Playing Video with VidCap and Video for Windows   85



s 

d. 
d 
 A 

uter 
bits 

on of 
wer 

to a 
th 
ing 

deo 
ce 
s no 
256 

e 

k 
is 

l of 
video input source, and do not choose VTR mode, the resulting picture i
unstable.

Jack Carries Program/Alpha

The Jack Carries controls are available only when an output jack is selecte
These controls allow you to output program video on one output jack an
Alpha video on another. Many computer graphics images have RGB and
components. RGB is the program video and A is the Alpha video. Comp
graphics video can often be configured as RGBA8 (8 bits of RGB and 8 
of Alpha), or RGB5_A1 (5 bits of RGB and 1 bit of Alpha). 

The Alpha component of the video determines the opaqueness of a porti
the video. The higher the Alpha number, the more opaque the video; the lo
the number, the more transparent the video. Before RGB can be output 
monitor, it is converted to YUV or YCrCb, and the Alpha is stripped off. Wi
the workstation, you can preserve the Alpha portion of the video by send
it out on a separate jack from the color video, thus preserving all of the vi
components. The Alpha portion of the video signal becomes the luminan
(Y) component of a video signal and, when presented on a monitor, carrie
color information. In the case of 8-bit Alpha, the Y component represents 
shades of gray; for 1-bit Alpha, it represents either white or black. 

Use the Jack Carries buttons to determine the jack that carries YUV and th
jack that carries Alpha.

Output Test Colorbars

The Output Test Colorbars check box is available only when an output jac
is selected. When this box is checked, the familiar colorbar test pattern 
available on the selected output jack.

Limit White Peak

The Limit White Peak check box is available only when an input jack is 
selected. The purpose of this control is to allow you to limit the input leve
a bad signal.
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Fast Color Time

The Fast Color Time check box is available only when an input jack is 
selected. If the button is activated, a fast time constant is in effect; if the
button is not activated, a normal time constant is in effect. Always leave
check box deactivated.

File Menu

The Silicon Graphics Video Control screen has two items under the File 
pulldown menu:

• Restore Default Settings for This Jack

• Graphics Display Framelock

Note: The third item, Exit , closes the screen.

The File pulldown menu is shown in Figure 3-17.

.

Figure 3-17 File Pulldown Menu
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Restore Default Settings for This Jack

When you choose this menu item, the default settings for the currently 
selected input or output jack are restored. This is a quick and easy way t
the settings back to a normal condition if you misadjust them.

Graphics Display Framelock

When you choose File > Graphics Display Framelock, the screen shown in 
Figure 3-18 appears.

Figure 3-18 Graphics Display Framelock

Genlock for your graphics display can come from an input or output vide
signal, which can be chosen using the Graphics Display Framelock panel. 
The video outputs can derive their timing from a video input, and vice ve
You cannot adjust genlock in real time—you have to restart the software
program every time you want to adjust the genlock source.
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Chapter 4

4. Capturing and Playing Video with HackTV and 
QuickTime

This chapter explains the details of the various panels and dialog boxes
encountered when capturing and playing back video using the HackTV 
application and QuickTime.

This chapter discusses the following topics:

• “HackTV Menu Bar and Monitor Window” on page 90

• “Video Compression Settings” on page 91

• “Video Image Settings” on page 92

• “Video Source Settings” on page 94

• “Silicon Graphics Video Output Settings” on page 96

• “Audio Compression Settings” on page 98

• “Audio Sample Settings” on page 100

• “Audio Source Settings” on page 102

This chapter goes into some detail explaining the panels and dialog box
used when capturing video using HackTV and QuickTime. The basic proc
of capturing video was explained in Chapter 1, “Getting Started.”

The two main screens that are notable are:

• HackTV Menu Bar

• Monitor Window
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HackTV Menu Bar and Monitor Window

To bring up the HackTV application, double-click the HackTV executable
file. If you do not have the HackTV application, you can download it from
Apple’s Web site.

The HackTV menu bar appears, along with real-time video playing in the
Monitor  window, as shown in Figure 4-1. If video does not appear in the
Monitor  window, double-check the connections as explained in “A Simp
Video Capture Example” on page 10.

.

Figure 4-1 HackTV Main Menu and Monitor Window
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Video Compression Settings

To configure the video compression settings for QuickTime, choose Video 
Settings... from the HackTV Monitor  menu. The Video screen appears with 
the topmost drop-down box indicating Compression, as shown in Figure 4-2. 
If the top drop-down box does not display Compression, click on the box and 
choose Compression.

.

Figure 4-2 HackTV Video Compression Window

This screen allows you to choose a video compression algorithm by using
Compressor drop-down box, the color depth by using the Depth drop-down 
box, and the quality and frame rate by using the other controls.

The topic of video compression is rather extensive, and is covered separ
(as are the options on this screen) in Chapter 5, “Silicon Graphics Video
Compression Techniques.” 
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Video Image Settings

To configure the video image settings for QuickTime, click the main select
drop-down box at the top of the Video window and choose Image, as 
illustrated in Figure 4-3.

.

Figure 4-3 HackTV Video Main Selection Drop-Down Box

The Video screen changes to show selections related to video image 
configuration, as shown in Figure 4-4.
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Figure 4-4 HackTV Video Image Screen

The Sharpness, Black Level, and White Level sliders are grayed out 
because they are not supported by the Silicon Graphics software.

The Silicon Graphics Video Control panel, explained earlier (see “Silicon 
Graphics Video Control Screen” on page 69) allows many more controls
be adjusted than those available on the QuickTime Video panel. Explanations 
for the settings on this screen are listed there also.
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Video Source Settings

To configure the video source settings for QuickTime, click the main 
selection drop-down box at the top of the Video window and choose Source. 
The Video Source screen appears, as shown in Figure 4-5.

.

Figure 4-5 HackTV Video Source Screen.

Digitizer

The Digitizer  drop-down box allows you to choose either Non-Square or 
Square pixels. Refer to “Pixel Aspect Ratio” on page 62 for more details 
regarding square and non-square pixels.

Input

The Input  drop-down box allows you to choose the S-Video input jack or the 
Composite input jack as video input sources.
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Format

The Format drop-down box allows you to choose one of three video timi
formats:

• NTSC

• PAL

• SECAM

Filter

The Filter  radio buttons allow you to choose either TV, LaserDisc or VCR. 
The purpose of this control is to compensate for VCR timing jitter resulti
from the slight variations inherent in an electromechanical systems. If yo
choose TV or LaserDisc, you are assuming a stable input source. If you u
a VCR as a video input source, and do not choose VCR mode, the resulting 
picture is unstable.
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Silicon Graphics Video Output Settings

To configure the Silicon Graphics video output settings for QuickTime, 
double-click the sgiqtvout.exe icon, at C:\WINNT\system32\sgiqtvout.exe. 
The screen shown in Figure 4-6 appears.

.

Figure 4-6 Silicon Graphics QuickTime Output Settings

This panel configures the video sent out to an external monitor or other v
equipment.

Analo g Channel

Use the Analog Channel drop-down box to choose one of the following 
video output jacks:

• Composite

• S-Video
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Format

Use the Format drop-down box to choose one of the following video outp
timing standards:

• NTSC

• PAL

Enable Square to Non-Square Pixel Conversion

Activate this check box if you want to output video to a digital device tha
requires non-square pixels. If you have captured analog video with the Sil
Graphics Square selection on the Source drop-down box in the QuickTim
Video window (see “Video Source Settings” on page 94), and you need 
output the video to a device that requires rectangular pixels, you must act
this check box to enable square to non-square pixel conversion. 
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Audio Compression Settings

To configure the audio compression settings for QuickTime, choose Audio 
Settings... from the HackTV Monitor  menu. The Sound screen appears with 
the topmost drop-down box indicating Compression, as shown in Figure 4-7. 
If the box does not contain Compression, click on the box and choose 
Compression.

.

Figure 4-7 HackTV Sound Compression Screen

Compressor

When you click the Compressor drop-down box, several choices are 
presented. However, because none of the audio compressors available 
Compressor drop-down box are supplied by Silicon Graphics, they are n
explained here. To get information about the compressors from various 
companies, contact the respective company directly, or look on the Appl
Web site for QuickTime (www.apple.com/quicktime).
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Speaker

Clicking the Speaker drop-down box yields the following choices:

• Off—mutes the speakers

• On—turns on the volume to the speakers

• Off While Recording—mutes the speakers while recording a video c

Volume/Gain

The Volume and Gain sliders affect the record audio levels.

Level Meter

The Level meter reflects the playback volume.
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Audio Sample Settings

To configure the audio sample settings for QuickTime, click the main 
selection drop-down box at the top of the Sound window and choose Sample, 
as illustrated in Figure 4-8.

.

Figure 4-8 HackTV Sound Sample Screen

C Rate (Clock Rate)

The C Rate drop-down box allows you to configure the following audio 
sampling rates:

• 44 kHz—provides CD-quality audio

• 22 kHz—provides medium quality audio

• 11 kHz—provides low-quality audio

You must decide on the audio quality desired based on your application
the amount of memory and disk space you want to allocate.
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Size

The two Size radio buttons, 8 bits and 16 bits, determine how accurately e
sample reflects the original analog audio. 16-bit sampling provides 
higher-quality audio than 8-bit sampling, but takes up more storage spa

Use

The two Use radio buttons, Mono and Stereo, allow you to monitor two input 
audio jacks and merge them into one audio stream (Mono), or to keep th
separated (Stereo).
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Audio Source Settings

To configure the audio source settings for QuickTime, click the main 
selection drop-down box at the top of the Sound window and choose Source, 
as illustrated in Figure 4-9.

.

Figure 4-9 HackTV Sound Source Screen

This panel allows you to set up the source for audio recording. The Built-in  
device is the integrated audio support available with the workstations. As
add more support for audio, such as the Silicon Graphics DA1100 Digita
Audio Card, the Device and Input  windows reflect more choices. 

The Silicon Graphics Audio Control panel, explained earlier (see “Silicon 
Graphics Audio Control Panels” on page 45) allows additional controls to
adjusted. For more information about the audio settings on the right side
the screen, see “QuickTime Audio Settings Panels” on page 41.
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Chapter 5

5. Silicon Graphics Video Compression 
Techniques

This chapter explains the details of how to use the various video compres
panels and dialog boxes when capturing video with the Silicon Graphics 
and Silicon Graphics 540 workstations. Video compression is necessary
keep file sizes small and bit rates low while retaining good video quality.

This chapter discusses the following topics:

• “Compression with Video for Windows” on page 104

• “Compression with QuickTime” on page 113

• “Video Playback Using Media Player” on page 119
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Compression with Video for Windows

When you use Video for Windows, two areas cover compression:

• Silicon Graphics VFW Capture Settings window

• Video Compression window

Silicon Graphics VFW Capture Settin gs Window

When using Video for Windows, you can configure video compression w
the Silicon Graphics VFW Capture Settings window, shown in Figure 5-1. 
You bring up the window by using the Options menu of the VidCap main 
screen to choose Video Format, Video Source, or Video Display. Each 
choice takes you to the Silicon Graphics VFW Capture Settings screen. 
Only the compression aspects provided by this screen are discussed in 
chapter; see Chapter 3, “Capturing and Playing Video with VidCap and Vi
for Windows” for more information on the other areas of the screen.

Figure 5-1 Silicon Graphics VFW Capture Settings Window
104   Chapter 5



re 

 

If 
-bit 

t 
lpha 

 

ach 
es 

e 
The Captured AVI File Settings area of this screen allows you to configu
video compression with the following controls:

• Image Format drop-down box

• Quality  radio button and slider

• Bit Rate radio button and drop-down box

• Use Software Codec check box

Image Format Drop-Down Box

When you click the Image Format drop-down box, the following choices are
presented: 

• Uncompressed 32-bit BGRA—a 32-bit uncompressed video format 
with 8-bit blue (B), green (G), red (R), and alpha (A) components in 
each pixel. Use this format to capture video that includes alpha1, or 
opacity, information. This format also allows you to capture the full 
pixel component, with no subsampling, similar to the UYVY format. 
you want to work in the RGB color space, use the uncompressed 32
BGRA format.

• Uncompressed 16-bit BGR—an uncompressed video format with 5-bi
blue (B), green (G), and (R) components in each pixel. There is no a
component as in BGRA (the extra bit is ignored).

• Uncompressed 16-bit UYVY—an uncompressed 4:2:2 format in 
which the first pixel contains an 8-bit U and an 8-bit Y1 component, 
with the next pixel containing an 8-bit V and an 8-bit Y2 component.
This format is recommended by Silicon Graphics.

• Uncompressed 8-bit Grayscale—an uncompressed video format in 
which each pixel carries only luma (Y) information, with 8 bits 
(256 shades) of gray.

• Motion JPEG (MJPEG)—this format is a popular compression 
algorithm for video capture editing because it separately captures e
field in a video frame, which allows you to cut between arbitrary imag
when editing. Other algorithms that do interframe coding, such as 
MPEG, do not lend themselves to video editing, because each fram

1 For more information about alpha, see “Jack Carries Program/Alpha” on page 86.
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may or may not carry full video content. The advantage of MJPEG o
all varieties of MPEG is the fact that MJPEG does not disturb the 
individual fields in the video. The MPEG compression technique 
exploits the redundancy in moving pictures by generating P frames 
B frames. These are virtual pictures, which do not exist as real video
frames, so any attempt to use them as a reference for editing is like
generate unpredictable results. MJPEG is ideal for video editing 
because it allows editing on a frame-by-frame basis.

• Photo JPEG—compared to MJPEG, Photo JPEG provides good 
compression ratios, but has less quality because it compresses a fra
a time instead of a field at a time. So, if there is motion from one field
the next, video compressed with Photo JPEG has some blurring. Ph
JPEG uses the same compression techniques as MJPEG.

• Baseline—available if the Compression card is present. This is the los
JPEG compression baseline standard.

• Lossless—available if the Compression card is present. This is the 
lossless JPEG compression standard, which achieves around 25% 
compression.

The available compressors (see “Video Compression Using Options > 
Compression...,” on page  108) depend on the image format you choose
you choose Motion JPEG, for example, there are no compressors that 
understand how to compress video that is already compressed, so the o
option available is No Recompression. More details are given in the sec
titled “Video Compression Using Options > Compression....”

Quality Radio Button and Slider

The Quality  radio button and slider are available for versions of JPEG (Ph
JPEG or MJPEG), whether available with software or accelerated with th
Silicon Graphics MJ1100 M-JPEG Compression card.

Clicking the Quality  button causes the compressor to adjust the compress
ratio such that the quality of the picture remains constant. The slider, wh
is adjustable between 0 and 100, indicates the level of quality you want 
maintain, with 100 being the highest quality. A quality level of 100 results
a compression ratio of approximately 2:1.

These controls allow you to make adjustments to the amount of detail in
image, and allow the bit rate to increase or decrease to maintain the qua
level indicated by the slider. 
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Bit Rate Controls

The Bit Rate radio button and box are grayed out until an MJPEG 
Compression card is plugged in. Clicking the Bit Rate radio button causes the
compression algorithm to maintain a constant bit rate for capturing video. 
the box to specify the bit rate in kbps. This technique allows you to fill up 
disk at a known rate regardless of the video content. However, unless yo
a sufficiently high bit rate, the video quality may suffer when capturing fa
action, high-content video.

The constant bit rate technique works well for creating an edit decision l
where high-quality video is not important, and all you need is enough con
to see and recognize the captured video.

Use Software Codec Check Box

This check box is grayed out until an MJPEG Compression card is plugg
in. When the card is present, the Silicon Graphics MJPEG and Silicon 
Graphics JPEG image formats use the Compression card for all the ima
supported by the board, but the board only supports images that are mult
of 8 in each dimension (such as 160 x 120 or 720 x 480). An exception i
image heights of 243 or 486 (the NTSC heights for fields or frames, 
respectively).

If you check the box, software compressors are used instead of hardwa
compression on the card. 
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Video Compression Usin g Options > Compression...

Another way of configuring video compression is to choose Options > 
Compression... in the VidCap main window. When you do this, the Video 
Compression screen appears, as shown in Figure 5-2.

Figure 5-2 Video Compression Screen

Compressor

When you click the Compressor drop-down box, the available compressor
are shown, as illustrated in Figure 5-3.

Figure 5-3 Compressors

When you configure video compression using the Video Compression 
window, the workstation video digitizer captures video to a memory buffe
an uncompressed pixel format. The contents of the memory buffer then 
from the video capture driver to the video compression driver you have 
selected from those among the list in Figure 5-3. To see another view of
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available compressors, go to Start > Settings > Control Panel and 
double-click on Multimedia . The Multimedia Properties window appears. 
Choose the Advanced tab and click Video Compression Codecs. See 
Figure 5-4.

Figure 5-4 Available Video Compression Codecs

The list (either in the Video Compressor window or in the Multimedia 
Properties window) shows all of the compressors that are available with 
particular format selected with the Image Format drop-down box in the 
Silicon Graphics VFW Capture Settings window (see Figure 5-1).
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Of the software compressors in the list shown in Figure 5-3, the Silicon 
Graphics compressors are:

• SGI YUV-RGB Codec—this codec accepts 16-bit BGR or 32-bit 
BGRA video format, and sends it to a software color conversion 
compression driver that converts the video format into to 4:2:2 YUV
format. This same codec also plays back video to an RGB color mon
(see “Video Playback Using Media Player” on page 119).

• SGI JPEG—compared to MJPEG, SGI JPEG provides good 
compression ratios, but has less quality because it compresses a fra
a time instead of a field at a time. So, if there is motion from one field
the next, video compressed with SGI JPEG has some blurring. SGI 
JPEG uses the same compression techniques as MJPEG.

• SGI Motion JPEG (MJPEG)—this format is a popular compression 
algorithm for video capture editing because it separately captures e
field in a video frame, which allows you to cut between arbitrary imag
when editing. Other algorithms that do interframe coding, such as 
MPEG, do not lend themselves to video editing, because each fram
may or may not carry full video content. The advantage of MJPEG o
all varieties of MPEG is the fact that MJPEG does not disturb the 
individual fields in the video. The MPEG compression technique 
exploits the redundancy in moving pictures by generating P frames 
B frames. These are virtual pictures, which do not exist as real video
frames, so any attempt to use them as a reference for editing is like
generate unpredictable results. MJPEG is ideal for video editing 
because it allows editing on a frame-by-frame basis. SGI Motion JP
is compatible with the Open DML MJPEG standard.

For information on the other compressors, contact the company that prov
the respective compressor.

Compression Quality

The Compression Quality slider is grayed out unless you are using a cod
that actually compresses video. The Compression Quality slider adjusts the 
software compressor to maintain a constant picture quality. As picture con
changes, the software adjusts its coefficients and adjusts the bit rate up
down to maintain the quality level indicated by the slider, from least to be
Use this slider control when you are more concerned about quality than 
amount of disk space taken up with a video clip. The best quality setting
cause frame or field dropouts.
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Key Frame Check Box

For the Silicon Graphics compressors, the Key Frame check box is available 
for compressors that do interframe coding. A key frame is a video frame 
contains full video content, and is used in MPEG-2 as a reference for ot
frames containing video difference information. If the software compress
you have chosen does differencing between frames (for example, MPEG
Indio, and Cinepak), check the Key Frame check box and enter a number fo
how often you want a key frame to occur (a rule of thumb is one key fram
every 30 frames).

The Key Frame box is grayed out for the SGI JPEG compressor because
every frame is a key frame.

Configure Button

For the Silicon Graphics compressors, the Configure button is grayed out 
unless a compression card is plugged in. If a card is plugged in and you 
Configure with a Silicon Graphics compressor in the Compressor 
drop-down box, the Configure Encoder screen shown in Figure 5-5 appear

Figure 5-5 Silicon Graphics Encoder Screen
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The screen shown in Figure 5-5 has two sets of controls:

• Baseline Compressor

– Quality radio button and slider—check the button and use the 
slider to configure the quality of the video capture. The bit rate 
then is allowed to increase or decrease to maintain the quality 
you choose.

– Bit Rate radio button—check this button to maintain a 
constant bit rate for the video capture.

– Use Software Codec check box—activating this check box 
causes software compressors to be used instead of hardware 
compression on the compression card.

• Lossless Compression radio button—check this button to allow 
lossless compression as defined by the JPEG standard.
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Compression with QuickTime

When using HackTV with QuickTime, you can configure video compress
with the Video window. Bring up the window by choosing Video Settings... 
from the HackTV Monitor  menu. The Video screen appears with the topmos
drop-down box indicating Compression, as shown in Figure 5-6. If the top 
drop-down box does not display Compression, click on the box and choose
Compression.

Figure 5-6 HackTV Video Compression Window
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Compressor Drop-Down Box

The Compressor drop-down box allows you to choose a software 
compression algorithm. Figure 5-7 shows an example of the list of availa
choices.

Figure 5-7 Software Compressor Choices

The list reflects all of the compressors that are registered with QuickTim
QuickTime provides a video digitizer and an Image Compression Manag
(ICM) to convert from one format to another. Silicon Graphics has move
some of the QuickTime library components for video compression and 
conversion from the ICM into hardware, thus achieving greater efficiency 
acceleration in some cases.

Silicon Graphics provides decompressors for the DV-NTSC and DV-PAL  
compressors shown in the list. These decompressors are decompress 
DV-NTSC or DV-PAL compressed video in real time.
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Of the software compressors on the list shown in Figure 5-7, Silicon Grap
provides eight of them:

• SGI 2vuy—an uncompressed 4:2:2 format in which the first pixel 
contains an 8-bit U and an 8-bit Y1 component, with the next pixel 
containing an 8-bit V and an 8-bit Y2 component. This is the preferr
format.

• SGI 5551—a 16-bit RGBA format, in which the pixels contain 5-bit re
(R), green (G), and blue (B) components, plus a 1-bit alpha (A) 
component. Use this compressor for RGB formats on a Silicon Graph
workstation.

• SGI ABGR—a 32-bit format, in which the pixels contain 8-bit alpha 
(A), blue (B), green (G), and red (R) components. Use this compres
for compatibility with the Apple Macintosh platform. Use this 
compressor also for RGB formats on a Silicon Graphics workstation

• SGI BGRA—a 32-bit format, in which the pixels contain 8-bit blue (B)
green (G), red (R), and alpha (A) components. Use this format when
target system is another Windows platform (not a Silicon Graphics 
workstation). 

• SGI L555—a 16-bit ARGB format, in which the pixels contain a 1-bit
alpha (A) component, and 5-bit red (R), green (G), and blue (B) 
components. The L indicates little-endian bit ordering. Use this form
when the target system is another Windows platform (not a Silicon 
Graphics workstation).

• SGI Motion JPEGA1—a format compatible with the Apple M-JPEGA
standard, but with better performance. The file created with this 
compressor is compatible and playable on standard Apple codecs 
running under the Windows and Apple operating systems. 

• SGI Photo JPEG1—a format compatible with the Apple QuickTime 
Photo JPEG standard.

• SGI RAW—the Silicon Graphics version of Apple’s ARGB format, 
only faster. Use for Macintosh-based system compatibility. 

1 On a dual-processor system that implements the Silicon Graphics DS110 Disk Array, 
the SGI JPEG codecs provide real-time 30 fps capture and a quality factor of up to 90% 
(9:1 compression). The quality factor reflects how much detail, and therefore how 
many bits, are used to make up the video image.
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For information on the operation of the other compressors, contact the 
respective company responsible for the compressor.

Depth Drop-Down Box

The Depth drop-down box shown in Figure 5-8 lets you choose the color
depth and is compressor-dependent.

Figure 5-8 Color Depth Choices

If you have selected SGI RAW, the available choices are:

• 256

• Thousands

• Millions

Choose 256 (Y component only), Thousands (16-bit 1555 big endian), or 
Millions  (23-bit ARGB) of colors.
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Quality Slider

The Quality  slider causes the software compressor to adjust the compres
such that the quality of the picture remains constant. The slider, which is
adjustable between Least and Best, indicates the level of quality you want to
maintain. As picture content changes, the software adjusts its coefficients
adjusts the bit rate up and down to maintain the quality level indicated by
slider. Use this slider control when you are more concerned about quality 
the amount of disk space taken up with a video clip.

Frames Per Second Drop-Down Box

Figure 5-9 shows the choices that are available when you click the Frames 
per second drop-down box.

Figure 5-9 Frames per Second Choices

The choices are:

• 30—the nominal NTSC rate

• 29.97—the standard NTSC rate
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• 25—the PAL rate

• 24— the film rate

• 15, 12, 10, and 8—these rates are normally used for web authoring

Key Frame Check Box

For the Silicon Graphics compressors, the Key Frame check box is available 
for compressors that do interframe coding. A key frame is a video frame 
contains full video content, and is used in MPEG-2 as a reference for ot
frames containing video difference information. If the software compress
you have chosen does differencing between frames (for example, MPEG
Indio, Sorenson, and Cinepak), check the Key Frame check box and enter a 
number for how often you want a key frame to occur (a rule of thumb is o
key frame every 30 frames).

The Key Frame box is grayed out for the SGI codecs because every fram
a key frame. This is typical of uncompressed MJPEG and DV formats tha
not apply intraframe compression techniques.

If your target is the Web, CD-ROM, or DVD-ROM, you may want to captu
using one of the compression codecs, such as Sorenson, to allow you to
directly distribute captured material.

Limit Data Rate Check Box

Clicking the Limit Data Rate check box causes the software compressor
maintain a constant bit rate for capturing video. Use the box to the side 
specify the bit rate in Kbps. This technique allows you to fill up the disk a
known rate regardless of the video content. However, unless you set a 
sufficiently high bit rate, the video quality may suffer for fast action video
content.

The constant bit rate technique works well for making up an edit decision 
where high-quality video is not important, and all you need is enough con
to see and recognize the captured video.
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Video Playback Using Media Player

Captured video files can be played back using Media Player. To bring up
Media Player, go to the taskbar on your workstation and choose Start > 
Programs > Accessories > Multimedia  > Media Player.

If you capture video in RGB format, the SGI YUV-RGB recompressor allo
you to change the format from RGB to YUV for display on an external vid
monitor. 

Because the YUV format is not supported by Video for Windows, if you 
capture video in 16-bit YUV, the SGI YUV-RGB recompressor converts fro
YUV to RGB so that the video can be displayed on the computer screen

If you play a file captured in the YUV format, it is automatically routed to th
SGI YUV-RGB codec. The codec converts from YUV to RGB and sends 
RGB video to the computer screen. In parallel, it sends YUV video to an
externally attached video monitor.
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Appendix A

A. NTSC and PAL

This appendix contains overviews of the NTSC and PAL standards, as we
tables listing the countries in which the NTSC and PAL standards are us
The information in these tables is subject to change and is presented he
reference only.

NTSC Standard Use by Nation

The National Television System Committee (NTSC) did most of the work
developing a color transmission standard in the United States. This stan
approved by the Federal Communications Commission in 1953, was 
compatible with the then-current 525-line, 60 fields per second, 2:1 interla
monochrome standard. Because of the audio subcarrier at 4.5 MHz, the 
transmission was required to occupy the same bandwidth as the monoch
video signal, 0–4.2 MHz.

There are several variations of the NTSC standard, including the 
non-interlaced NTSC, which uses 262 lines and 30 frames per second. 
standard is commonly used in video games and onscreen displays. How
the technical broadcast video standard is (M) NTSC. The M refers to the
monochrome standard for line and field rates (525/59.94), an audio carr
frequency 4.5 MHz above the video carrier frequency, a video bandwidth
4.2 MHz, and an RF channel bandwidth of 6 MHz.
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The (M) NTSC standard is used for both VHF and UHF video transmissi
The (M) NTSC standard is in use in the countries listed in Table A-1. A (
after a country’s name indicates that country supports only VHF.

PAL Standard Use by Nation

Europe did not implement a television standard until 1967, when Germa
and the United Kingdom began broadcasting slightly different variants of 
Phase Alternation Line (PAL) system. This system uses a color transmis
standard compatible with the 625-line, 50 field per second, 2:1 monochro
standard.

As with the NTSC standard, there are several variants of the PAL standa
depending on the video bandwidth and placement of the audio subcarrier
PAL composite video signal has a bandwidth of   4.2, 5.0, 5.5, or 6.0 MH

Antigua Aruba Bahamas (V)

Barbados (V) Belize (V) Bermuda (V)

Bolivia Burma (V) Canada

Chile Colombia Costa Rica

Cuba Çuracao Dominican Republic

Ecuador El Salvador (V) Guam (V)

Guatemala Honduras Jamaica

Japan Mexico Montserrat (V)

Mynamar (V) Nicaragua Panama

Peru Philippines Puerto Rico

St. Christopher and St. 
Nevis (V)

Samoa (V) South Korea

Suriname (V) Taiwan Trinidad/Tobago

USA Venezuela Virgin Islands (V)

Table A-1  NTSC Standard Use by Nation
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depending on which variant of the standard is used. The variants of the 
standard are B, D, G, H, I, or Combination PAL, with the variant being lis
in parentheses, such as (I) PAL. A noninterlaced PAL, most commonly u
in video games and on-screen displays, uses 312 lines per frame.

If you need greater detail about the specifications of the PAL standard, r
to the International Telecommunications Union documentation.

The (I) PAL standard is used for both VHF and UHF transmission. The 
following countries use the (I) PAL standard. Countries that use the stand
only for UHF transmission are followed by (U).

The (B) PAL standard is used for VHF transmission except in special ca
The following countries use the (B) PAL standard. Countries that use the
standard also for UHF transmission are followed by (U).

Angola Botswana Gambia

Guinea-Bissau Hong Kong (U) Ireland

Lesotho Malawi Namibia

Nigeria (U) South Africa Tanzania

United Kingdom Zanzibar

Table A-2  (I) PAL Standard Use by Nation

Albania Algeria Australia (U)

Austria Bahrain Bangladesh

Belgium Bosnia-Herzegovina Brunei Darussalam

Cambodia Cameroon Croatia

Cyprus Denmark Egypt

Ethiopia Equatorial Guinea Finland

Germany Ghana (U) Gibraltar

Greenland Iceland India

Indonesia Israel Italy

Table A-3  (B) PAL Standard Use by Nation
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The (N) PAL standard is used for both VHF and UHF transmission. The 
following countries use the (N) PAL standard. Countries that use the stan
only for VHF transmission are followed by (V).

The (G) PAL standard is used for UHF transmission except in special ca
The following countries use the (G) PAL standard. Countries that also use
standard for VHF transmission are followed by (V).

Jordan Kenya Kuwait

Liberia Libya Luxembourg

Malaysia Maldives Malta

Nepal Netherlands New Zealand

Nigeria Norway Oman

Pakistan Papua New Guinea Portugal

Qatar Sao Tomé and Principe Saudi Arabia

Seychelles Sierra Leone Singapore

Slovenia Somali Spain

Sri Lanka Sudan Swaziland

Syria Thailand Tunisia

Turkey Uganda United Arab Emirates

Yemen

Argentina Paraguay Uruguay (V)

Table A-4  (N) PAL Standard Use by Nation

Albania Algeria Austria

Bahrain Bosnia/Herzegovina Cambodia

Cameroon Croatia Cyprus

Table A-5  (G) PAL Standard Use by Nation

Table A-3  (B) PAL Standard Use by Nation
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The (D) PAL standard is used for both VHF and UHF transmission. The 
following countries use the (D) PAL standard. Countries that use the stan
only for VHF transmission are followed by (V).

The (H) PAL standard is used for UHF transmission in Belgium.

Denmark Egypt Ethiopia

Equatorial Guinea Finland Germany

Gibraltar Greenland Iceland

Israel Italy Jordan

Kenya Kuwait Liberia

Libya Luxembourg Malaysia

Monaco Mozambique (V) Netherlands

New Zealand Norway Oman

Pakistan Papua New Guinea Portugal

Qatar Romania Sierra Leone

Singapore Slovenia Somalia

Spain Sri Lanka Sudan

Swaziland Sweden Switzerland

Syria Thailand Tunisia

Turkey United Arab Emirates Yemen

Zambia (V) Zimbabwe (V)

China North Korea (V) Romania (V)

Table A-6  (D) PAL Standard Use by Nation

Table A-5  (G) PAL Standard Use by Nation
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Glossary

ADAT Optical interface

The ADAT Optical interface provides a unidirectional point-to-point 
conversion of 8 tracks of 24-bit digital audio, with subcodes, at professio
sampling rates, on a single consumer-grade optical fiber. A typical use is
data connection between multiple ADAT tape decks, for bouncing tracks
between the decks.

black level

In the active video portion of the video waveform, the voltage level that 
defines black.

blank level

The signal level at the beginning and end of the horizontal and vertical 
blanking intervals, typically representing zero output (0 IRE).

brightness

The intensity of the video level relative to the display.

CCIR-601

The digital interface standard developed by the CCIR (Comité Consultat
International de Radiodiffusion, or International Radio Consultative 
Committee). It is based on component color encoding, in which the 
luminance and chrominance (color difference) sampling frequencies are
related in the ratio 4:2:2: four samples of luminance (spread across four
pixels), two samples of CR color difference, and two samples of CB colo
difference. The standard, also referred to as 4:2:2, sets parameters for b
525-line (NTSC) and 625-line (PAL) systems.
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chroma (also chrominance)

In an image reproduction system, a separate signal that contains the co
information. Black, white, and all shades of gray have no chrominance a
contain only the luminance (brightness) portion of the signal. However, a
colors have both chrominance and luminance.

Chrominance is derived from the I and Q signals in the NTSC television
system and the U and V signals in the PAL television system. See also luma.

color burst

The segment of the horizontal blanking portion of the video signal that is u
as a reference for decoding color information in the active video part of t
signal. The color burst is required for synchronizing the phase of 3.58 M
oscillator in the television receiver for correct hues in the chrominance sig

In composite video, the image color is determined by the phase relation
of the color subcarrier to the color burst. The color burst sync is 8 to 11 cy
of 3.58 MHz color subcarrier transmitted on the back porch of every 
horizontal pulse. The hue of the color sync phase is yellow-green.

Also called “burst” and “burst flag.”

contrast

The difference between the darkest blacks and the whitest whites in the v
signal. The greater the difference, the higher the contrast.

gain

The intensity of the video or audio signal. In audio, gain is normally 
associated with volume. In video, gain is the amount of a specific color sig
or amount of a combination of color signals.

gain hysteresis

The lag between adjusting a gain control and when the adjustment take
effect.

genlock

Synchronizing with another video signal serving as a master timing sour
The master timing source can be a composite video signal, a video signal
no active video (only sync information), or, for video studio, a device cal
house sync.

hue

The designation of a color in the spectrum, such as cyan, blue, or mage
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Sometimes called tint on NTSC television receivers. The varying phase 
angles in the 3.58 MHz (NTSC) or 4.43 MHz (PAL) C signal indicate the
different hues in the picture information.

luma (also luminance)

The perceived brightness of a surface. Typically refers to a weighted ave
of red, green, and blue color values that gives the perceived brightness o
combination. For video systems, luminance is the video signal that descr
the amount of light in each pixel. See also chrominance.

NTSC

A color television standard or timing format encoding all of the color, 
brightness, and synchronizing information in one signal. Used in North 
America, most of South America, and most of the Far East, this standar
named after the National Television Systems Committee, the standardiz
body that created this system in the U.S. in 1953. NTSC uses a total of 
horizontal lines per frame, with two fields per frame of 262.5 lines each. E
field refreshes at 60 Hz (actually 59.94 Hz).

pixel aspect ratio

The ratio of the width to the height of an image. For example, the standa
aspect ratio for television is 4:3. Maintaining the original aspect ratio of a
image prevents it from being distorted.

PAL

A color television standard or timing format developed in West Germany a
used by most other countries in Europe, including the United Kingdom b
excluding France, as well as Australia and parts of the Far East. PAL us
total of 625 horizontal lines per frame, with two fields per frame of 312.5
lines per frame. Each field refreshes at 50 Hz. PAL encodes color differe
from NTSC. PAL stands for Phase Alternation Line or Phase Alternated 
Line. This system attempts to correct some of the color inaccuracies in NT
See also NTSC.

saturation

Color intensity; zero saturation is white (no color) and maximum saturati
is the deepest or most intense color possible for that hue. Saturation doe
mean brightness. In signal terms, saturation is determined by the ratio o
luminance level to chrominance amplitude. See also hue.
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sharpness

The clarity of the video signal, a combination of color, brightness, and 
intensity. Sharpness differs from focus.

S-Video

Video format in which the Y (luminance) and C (chrominance) portions of 
signal are kept separate. Also known as YC.

YCbYCr

The color space in 4:2:2 digital component video that allows compatibilit
among various television signal standards where Y is luma, Cb and Cr a
color difference signals that are scaled and offset versions of (Y,B’-Y) an
(R’-Y) signals.
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advanced controls for microphone,  36

AGC Updates Every Line/Field Radio Buttons,  82

Analog Process,  85

Analog to Digital Converters (ADCs),  43

aperture factor,  76

Apple QuickTime,  6

Audio Compression Settings,  98

Audio Control Panel
3D options,  48
freeze graphics,  47
hide recording controls,  47
show spectrum,  47

audio inputs for recording,  30

audio record level,  16

audio sampling rate (11 kHz, 22 kHz, 44 kHz),  43

audio settings panels (Windows Multimedia),  33

audio system architecture,  31

Automatic Gain Control AGC Check Box,  81

B

Baseline compressor,  112

Bit Rate Controls,  107

black level, blank level, H Phase, color burst 
sliders,  74

brightness,  61

brightness, contrast, saturation, and hue sliders,  73

C

capturing video using VidCap,  11

CCIR601,  63

chroma bandwidth,  76

Color Gain Sliders,  82

Color Standard Detect,  79

Composite In jack,  60

compression quality,  110

Compression using Video for Windows,  104

Compression with QuickTime,  113

Configure button,  111

connections to workstation,  10

contrast,  61

control panels,  7

creating a media file,  15

D

DA1100 Digital Audio Card,  44

Digital Audio Card (DA1100),  2

DirectSound,  54

Disk Array (DS1100),  2

displaying audio spectrum,  47

dithering,  60

E

example of video capture,  10

F

Fast Color Time,  87

features
320 workstation,  3
540 workstation,  5

Flat Panel Monitor (1600SW),  2
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freeze graphics,  47

G

Gain Hold Check Box,  81

Gain Hysteresis Slider,  83

Genlock Delay,  79

Genlock Source,  79

H

HackTV
application,  90
begin capturing video,  26
capturing video with,  19
playing back video,  27
selecting the audio format,  23
selecting the video format,  20
starting the application,  19

hardware overview,  2

hue,  62

I

Image Format drop-down box,  105

Image Formats
Baseline,  106
Lossless,  106
Motion JPEG (MJPEG),  105
Photo JPEG,  106
Uncompressed 16-bit BGR,  105
Uncompressed 16-bit UYVY,  105
Uncompressed 32-bit BGRA,  105
Uncompressed 8-bit Grayscale,  105

J

Jack Timing,  78

K

Key Frame check box,  111

key frames,  111

L

Limit White Peak,  86

Lossless compression,  112

Luma Delay,  85

M

media file, creating a,  15

media player,  119

microphone sensitivity,  37

microphone, advanced controls,  36

Microsoft Windows NT,  2

MIDI player,  52

MIDI player panel,  54

mixer controls,  46

MJPEG Compression Card,  2

N

NTSC
countries,  121
types of standards,  121

Nyquist criterion,  39
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Output Test Colorbars,  86

overview
hardware,  2
software,  6

P

PAL
countries,  122
types of standards,  122

Q

Quality Radio Button and Slider,  106

QuickTime
audio compression settings,  98
Audio Compressor drop-down box,  98
audio sample settings,  100
audio source settings,  102
Clock Rate drop-down box,  100
Color Depth Drop-Down Box,  116
compression algorithms,  42
Compressor drop-down box,  114
compressor drop-down box,  91
Digitizer drop-down box,  94
Filter radio buttons,  95
Format drop-down box,  95
Frames Per Second drop-down box,  117
Input drop-down box,  94
Level Meter,  99
Limit Data Rate Check Box,  118
Quality Slider,  117
Silicon Graphics Video Output settings,  96
Sound Compression panel,  41
Sound Sample control panel,  43
Sound Source control panel,  44
Speaker drop-down box,  99
speaker operation,  42

video image settings,  92
video source settings,  94
volume and gain controls,  42
Volume and Gain sliders,  99

QuickTime audio settings panels,  41

S

S-Video In jack,  60

sampling rate,  39

saturation,  62

Serial Digital Video Interface Board (DV1100),  2

setting the audio record level,  16

SGI Audio Panels
Digital Audio control panel,  50
Digital Audio Meter panel,  51

SGI Compressors
SGI 2vuy,  115
SGI 5551,  115
SGI ABGR,  115
SGI BGRA,  115
SGI JPEG,  110
SGI L555,  115
SGI Motion JPEG (MJPEG),  110
SGI Motion JPEGA,  115
SGI Photo JPEG,  115
SGI RAW,  115
SGI YUV-RGB Codec,  110

SGI Decompressors
DV-PAL,  114
DV_NTSC,  114

SGI Sound Mixer,  34

SGI Video Control
File Menu,  87
Gain Tab,  80
Graphics Display Framelock,  88
input jacks,  70
Misc Tab,  83
Restore Default Settings for This Jack,  88
select jack to control,  70
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Sharpness Tab,  75
Timing Tab,  77

SGI Video Out for QuickTime
Enable Square to Non-Square Pixel Conversion 

check box,  97
Format drop-down box,  97

SGI Video Out for Quicktime
Analog Channel drop-down box,  96

sharpness, black Level, and white level sliders 
(Quicktime),  93

show recording controls,  47

Signal Present,  78

Silicon Graphics 320 workstation,  3

Silicon Graphics audio control panels,  45

Silicon Graphics Audio Panels
audio control panel,  45
File Pulldown Menu,  47
Options Pulldown Menu,  47
playback functions,  46
record functions,  47

Silicon Graphics control panels,  7

Silicon Graphics VFW Capture Settings window,  
104

sliders
black level, blank level, H Phase, color burst,  74
color,  73
color gain,  82
gain hysteresis,  83
Quicktime,  93

software environment
Apple QuickTime,  9
Windows Multimedia,  7

software layers,  7

software overview,  6

software synthesizer,  52
configuration,  54
panel,  53

sound quality (CD, telephone, radio),  38, 39

T

tone controls,  37

U

Use Software Codec check box,  107

V

Vertical Noise Reduction,  84

VidCap,  11
begin capturing video,  17
captured AVI file settings,  62
capturing video,  11
enable video display on computer screen,  68
image format,  66
image size,  64
output jack,  67
output timing,  67
playing back the VidCap video,  18
restore defaults button,  66
selecting the audio format,  12
selecting the video format,  13
source jack,  60
source timing,  60
square to non-square conversion,  68
starting the application,  11
video out button,  67

video capture example,  10

Video Compression Settings,  91

video compression settings,  91

video compression using Options > Compression
108

video data rates,  65

video playback using media player,  119
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Windows Multimedia,  6
Attributes drop-down box,  39
Format drop-down box,  38
Name drop-down box,  38
Properties panel for playback control,  34
Properties panel for record control,  35
Sound Selection panel,  38
Volume Control panel,  33

Y

Yamaha S-YXG50 software synthesizer,  52

Yamaha special wave device,  55
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